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Warning !

1. Battery
Batteries on board are consumables.
The life time of them are not guaranteed.

2. Fless solution with HDD
The specification & limitation of HDD should be considered carefully when
the fanless solution is implemented.

3. We will not give further notification in case of changes of
product information and manual.

4. SATA interface does not support Hot SWAP function.
5. There might be a 20% inaccuracy of WDT at room temperature.

6. Please make sure the voltage specification meets the requirement
of equipment before plugging in.

7. Caution! Please notice that the heat dissipation problem could cause the MB
system unstable. Please deal with heat dissipation properly when
buying single MB set.

8. Please avoid approaching the heat sink area to prevent users from
being scalded with fanless products.

9.  If users repair, modify or destroy any component of product unauthorizedly,
We will not take responsibility or provide warranty anymore.

10. DO NOT apply any other material which may reduce cooling
performance onto the thermal pad.

11. Itis important to install a system fan toward the CPU to decrease
the possibility of overheating / system hanging up issues,
or customer is suggested to have a fine cooling system to dissipate heat
from CPU.




k Hardware Notice Guide

1. Before linking power supply with the motherboard, please attach DC-in adapter to

the motherboard first. Then plug the adapter power to AC outlet.

Always shut down the computer normally before you move the system unit or

remove the power supply from the motherboard. Please unplug the DC-in adapter first
and then unplug the adapter from the AC outlet.

Please refer photo 1 as standard procedures.

2. In case of using DIRECT DC-in (without adapter), please check the allowed range
for voltage & current of cables. And make sure you have the safety protection for
outer issues such as short/broken circuit, overvoltage, surge, lightning strike.

3. In case of using DC-out to an external device, please make sure its voltage and
current comply with the motherboard specification.

4. The total power consumption is determined by various conditions
(CPU/motherboard type, device, application, etc.). Be cautious to the power cable
you use for the system, one with UL standard will be highly recommended.

5. It’'s highly possible to burn out the CPU if you change/ modify any parts of
the CPU cooler.

6. Please wear wrist strap and attach it to a metal part of the system unit
before handling a component. You can also touch an object which is
ground connected or attached with metal surface if you don't have wrist strap.

7. Please be careful to handle & don't touch the sharp-pointed components on
the bottom of PCBA.

8. Remove or change any components form the motherboard will VOID the warranty of
the motherboard.

9. Before you install/remove any components or even make any jumper setting
on the motherboard, please make sure to disconnect the power supply first.
(follow the aforementioned instruction guide)

10. "POWERON after PWR-Fair” function must be used carefully as below:

When the DC power adaptor runs out of power, unplug it from the DC current;
Once power returns, plug it back after 5 seconds.

If there is a power outage, unplug it from the AC current, once power returns,
plug it back after 30 seconds. Otherwise it will cause system locked or made

a severe damage.

Remark 1:

Always insert/unplug the DC-in horizontally & directly to/from the motherboard.
DO NOT twist, it is designed to fit snugly.

Moreover, erratic pull / push action might cause an unpredictable damage to the
component & system unit.

___________________________________________________________________________|
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Photo 1 Insert

Unplug
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Chapter-1

General Information

The CI170A/C is an All-In-One board which is 7th/6th Gen Intel® Core™ i7/i5/i3 and
Pentium®/Celeron® Processor (formerly codenamed Skylake-S) based industrial
motherboard in the LGA1151 package with Intel® Q170 Express chipset. The CI170A/C
supports high-speed data transfer interfaces such as PCle3.0, USB 3.0, and SATA 6 Gb/s
(SATA 1l1), with dual-channel DDR4 2133 MHz memory up to 32 GB in two SO-DIMM slots
and supports 4 USB 3.0, 5 USB 2.0, 10 COM and 4 SATA lll ports, as well as graphics
interface for DVI-D, HDMI and DisplayPort displays.

High-performance and power-efficient communication platform, the embedded
motherboard of CI170A/C is specially designed for loT, industrial, digital signage, medial,
POS, retail and factory automation applications.Cl1170A/C with a wide variety of expansion
options including PCle(x16), PCle(x8), PCle(x4), PCle(x1), or 2 PCle(x8), 2 PCle(x4), 2
PCle(x1), selectable by raiser cards. The platform comes with five Intel Gigabit Ethernet
controllers and supports Wake-On LAN, vPro with TPM 2.0 and the PXE function in BIOS
for Intel LAN chipset, it is perfect control board for networking devices.

The CI170A/C also supports up to ten of serial ports RS232/RS422/RS485 auto switch
by BIOS settings and +5V/12V selectable by jumper. In addition, there are multi-ports of
Hi-Speed USB 3.0/2.0 to enhance the host controller interface which will ensure the high
performance level and flexible expansion. The expandable interfaces include 1 full-size
PCle Mini card for PCle x 1 or mSATA (auto-detection) and USB interface, and 1 full-size
PCle Mini card for PCle x 1 and USB interface. There are two SIM socket onboard for the
mini cards to get the 3G/4G communication easier and quickly.

The CI170C supports LVDS interface and touch controller onboard for touch panel and
1 panel inverter power for panel dimming control. It suitable for ALL-IN ONE Panel PC,
POS, Kiosk and automation control systems. The All-In-One motherboard 3I385AW/CW
is fully compatible with industry standards, plus technical enhancements and thousands
of software applications developed for IBM PC/AT compatible computers. These control
logic provides high-speed performance for the most advanced multi user and multitasking
applications available today.



1-1 Major Feature

1.

© ® N o

10.
1.

12.
13.
14.

15.
16.
17.

The Desktop Skylake S-Platform processor includes Integrated Display Engine, GPU

and Integrated Memory Controller. The processor is designed be offered in a LAG1151 package.
Intel Q170 Chipset Family Platform Controller Hub (PCH)

Supports Two Channels of DDR4 SO-DIMM SDRAM, Max. 32GB, data transfer rates of
1866MT/s and 2133 MT/s

Intel Desktop Skylake S-Platform Processor Integrated Graphics. GEN 9 architecture supports
up to 72 Execution Units (EUs), depending on the processor SKU.

Integrated Gigabit LAN Controller with Intel I219LM Gigabit Ethernet PHY supports

vPro. *1 Support 4 x 10/100/1000 Mbps Intel LAN ports.*2

Support DP, HDMI, DVI eDP1.3 2 lanes &18/24 bits dual channel LVDS Interface on Board. *3
Support 10 x RS232 auto switch to RS485/RS422 by BIOS, 4 port external, 6 port internal. *4

4 x type A USB3.0 external and 5 x USB 2.0 internal

ALC886 HD Audio Specification 1.0 Two channels sound. Two channel Class D Audio Amplifier. *5
Four SATA ports 3.0 Data transfer rates up to 6.0 Gb/s (600 MB/s)

Support extended 1 x Mini PCle card for PCle x 1, mSATA and USB interface, 1 x Mini PCle card
for PCle x 1 and USB interface. There are 2 x SIM Card Socket for these two mini cards.
(3G/4G LTE module)

One M.2 B-Key 2242 for PCle & mSATA devices

USB touch screen controller for CI170C only

Hardware digital Input & Output, 8 x DI / 8 x DO, Hardware Watch Dog Timer, 0~255 sec
programmable

PCle x 16 Golden Finger supports 1 PCle x 1, 4, 8,16 or 2 PCle x 1, 4, 8 with Riser Cards
Support TPM 2.0 *6

PCB Dimension: 200 x 150 mm

*1 & *6 CI170C only

*2 CI170A supports 2 LAN ports

*3 eDP & LVDS shared the same signal, LVDS for CI170C only

*4 CI170A supports 6 COM

*5 Audio Amplifier for C1170C only
|



1-2 Specification

1.

1.

12.

13.

14.
15.
16.
17.

CPU: Desktop Skylake S-Platform processor. The processor is designed be offered
in a LAG1151 package.

Memory: Two SO-DIMM slots for DDR4 SDRAM, Max. 32GB, data transfer rates of
1866MT/s and 2133 MT/s

Graphics: Intel Desktop Skylake S-Platform Processor Integrated Graphics.

GEN 9 architecture supports up to 72 Execution Units (EUs), depending on the
processor SKU. eDP 1.3 2 Lanes up to 1920 x 1200, DVI 1.2 2048 x 1080, DP 1.2
4096 x 2160, HDMI 1.3 up to 3840 x 2160

SATA: Integrated Serial ATA Host Controller Up to 4 SATA port, SATA Gen3 Data
transfer rates up to 6.0 Gb/s (600 MB/s).

LAN: Intel 1210-AT LAN chipset or Intel 1211-IT LAN chipset (Option) with
10/100/1000 Mbps

1/0 Chip: Chipsets for 10 ports RS232/422/485

USB: 4 type A USB 3.0 connector onboard and 6 USB 2.0 (internal)

Sound: Support line in, line out and MIC in, Audio Amplifier: Ti TPA2012D2RTJ
Class D 2.1W Audio amplifier

LVDS: support 24bits/2ch LVDS interface

WDT/DIO: Hardware digital Input & Output, 8 x DI / 8 x DO / Hardware Watch Dog
Timer, 0~255 sec programmable

Expansion interface: one full-size PCle Mini card for PCle x 1, mSATA and USB
interface, one full-size Mini PCle card for PCle x 1 and USB interface with 2 SIM
sockets. 1 M.2 for mSATA or PCle devices.

Touch screen: C8051F321 USB interface touch screen controller, support 4-, 5-, 8-
wire Analog resistive touch screen

Golden Finger: PCle x 16 Golden Finger supports 1 PCle x 1, 4, 8,16 or 2 PCle x 1,
4, 8 with Riser Cards

TPM: Infineon SLB 9665 TT 2.0 Trusted Platform Module

BIOS: AMI UEFI BIOS

Dimension: 200 x 150 mm

Power: DC IN +12V



1-3 Installing the CPU / PCH Heatsink. (Socket Version)

1. Install CPU bracket under the CPU first. 2.1. Locate Pin1 in the socket,look for a
golden narrow.

2. Use screw driver and screw the socket 2.2. Lock the CPU socket by securing the
screw in anti-clockwise direction. screw in an anti-clockwise direction .




3. Peel-off the Elastic Silicone sticker 3.2 Insert the system fan power cable to
under the Heat Sink. the pin header (FAN1) on board.

3.1 Tighten the HEAT SINK on the motherboard.
Pay attention to tighten the screws diagonally.




1-4 Vertical SO-DIMM assembly guide

1. Install the memory into SODIMM. 2. Press down firmly to ensure the memory
is locked.

Uninstall

1. Pull open both sides of the memory slot. 2. Take out the memory.




1-5 Directions for installing the Mini Card

1. Unscrew the screw on the board 2. Plug in the Mini Card in a 45 angle

f F T deen TP—
| )} ettt Cddt
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1-6 Directions for installing the Mini PCl-e Card (Full Size)

1. Unscrew the screw on the board 2. Plug in the Mini Card in a 45 angle

11



1-7 Packing List

Material Code |Description Detail Specification Quantit
1 |7G1901-1650001-0| MB-CI170C-ACXX-001 LF, CI170C-ACXX, Rev.:001 1
. LF, Intel Baytrail Driver, Windows
2 |6G8006-2349-0100( LEX Product Driver DVD 7/18.1 32/64 1
3 |6G6001-2203-0100| SATA DATA Cable (Red) LF, L=25cm 1
LF, L=25cm,
4 |6G6003-1009-0100 SATA Power Cable 1%5/2.0 to 180° SATA 15p 1
6G6003-1009-0100( 120W Power Adapter,12V LF, M4P/LOCK’F';SPP120'AHAN1’ 1
6 COOLER 1

*The packing list above is for the users who purchase single motherboard. The users

who purchase the board with chassis may refer to the packing list in the Assembly Guide.

Please contact with your dealer if any of these items is missing or damaged
on delivery. And please keep all parts of the delivery package with packing
materials in case if you need to deliver or store the product in the future.

12



Chapter-2

Hardware Installation

2-1 Unpacking Precaution

This chapter provides the information how to install the hardware of CI170A/C.
Please follow section 1-7, 2-1 and 2-2 to check the delivery package and unpack
carefully. Please follow the jumper setting procedure.

NOTE!

1. Do not touch the board or any other sensitive components without all necessary
anti-static protection.

2. Please pay attention to the voltage limitation of DC-IN12V 5%.
Overuse of DC-IN voltage limitation or change to another power adapter
(not provided with this system) will VOID warranty.

You should follow these

steps to protect the board from the static electric

discharge whenever you handle the board:

1. Ground yourself by a grounded wrist strap at all times when you
handle the CI1170A/C.
Well secure the ALLIGATOR clip of the strap to the end of the shielded wire lead from
a grounded object. Please put on and connect the strap before handling the
CI170A/C for harmlessly discharge any static electricity
through the strap.

2. Please use anti-static pad to put any components, parts, or tools on the pad whenever
you work on them outside the computer. You may also use the anti-static bag instead of

the pad. Please ask your local supplier for necessary parts on anti-static requirement.

3. Do not plug any connector or set any jumper when the power is on.

13



2-2 Unpacking checkup

First of all, please follow all necessary steps of section 2-1 to protect CI170A/C
from electricity discharge. With reference to section 1-7

please check the delivery package again with following steps:

1. Unpack the CI170A/C board and keep all
packing material, manual and driver disc etc, do not dispose !

2. Is there any components lose or drops from the board?
DO NOT CONTINUE TO INSTALL THIS BOARD!
CONTACT THE DEALER YOU PURCHASED
THIS BOARD FROM, IMMEDIATELY.

3. Is there any visible damage on the board?
DO NOT CONTINUE TO INSTALL THIS BOARD!CONTACT
THE DEALER YOU PURCHASED THIS BOARD FROM, IMMEDIATELY.

4. Check your optional parts (i.e. DDR, CF etc.), all necessary jumpers
setting to jumper pin-set, and CMOS setup correctly.
Please also refer to all information of jumper settings in this manual.

5. Check your external devices (i.e. Add-On-Card, Driver Type etc.)
for complete add-in or connection and CMOS setup correctly.

Please also refer to all information of connector connection in this manual.

6. Please keep all necessary manual and driver disc in a good condition for future
re-installation if you change your Operating System.

14



2-3 Dimension-CI170A/C

5.1

124.8
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2-4 Function MAP-CI170A/C

LCD Power

System FA 4 x SATA
LANL+— & o S 3 ; & Front Panel
USB Touch—— F i :
§ 8 DI/DO
= ililll“‘ SMBUS
~ Line-out+ = > ! _ - 5 "-r»;-t Qi 5x USB2.0
/L|ne'|n/M|C'|n I 1 M +12v/+5v Output
Audio AMP-L/R PCIe/USB COM5~10(R8232/422/485)
Auto Detect/
USB/mSATA PS2 KB/MS
bVvi LAN3 LAN2
5

Display port HDMI COM 1~4 LAN4  ysB3.0/2.0
(RS232/422/485)

16



2-5 Connector MAP-CI170A/C
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2-6 Diagram-CI170A/C
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2-7 Install Memory

This motherboard provides one 260-pin Small Outline Dual In-line Memory Module (SODIMM)

socket for memory expansion available maximum to of 4GB/8GB/16GB DDR4 SDRAM.
DDRA4 clock supports: DDR4 1866/2133MT/S

Valid Memory Configurations

Total Memory
DIMM1 / 2 System Accept or Not
Max.
DS Accept 16GB
NOTE!

The detected memory size is less than actual installed memory size since
some memory has been allocated for system use.
That’s how PC works with system memory.

Please refer to page 9 for installation of memory module.

19



2-8 List of Jumpers
JCMOS1: CMOS clear select

JVC1: COM1 voltage select

JVC2: COM2 voltage select

JVC3: COM3 voltage select

JVC4: COM4 voltage select

JVC5: COMS5 voltage select

JVC6: COMG voltage select

JVC7: COMY voltage select

JVC8: COMS voltage select

JVC9: COM9 voltage select

JVC10: COM10 voltage select
JVP1: LVDS Panel Inverter power select
JVL2: LVDS/eDP Panel power select

2-9 Jumper Setting Description

A jumper is ON as a closed circuit with a plastic cap covering two pins. A jumper is OFF
as an open circuit without the plastic cap. Some jumpers have three pins, labeled 1, 2,
and 3. You could connect either pin 1 and 2 or 2 and 3.The below figure 2.2 shows the

examples of different jumper settings in this manual.

Figure 2.2
ON
I[E]e (o]
1-2 2-3

All jumpers already have its default setting with the plastic cap inserted as ON,
or without the plastic cap as OFF. The default setting may be referred in this

LLEE )

manual with a symbol .

20



2-10 JCMOS1: CMOS DATA Clear

A battery must be used to retain the motherboard configuration in CMOS RAM.
Close Pin1 and pin 2 of JCMOS1 to store the CMOS data.

To clear the CMOS,follow the procedures below:

1. Turn off the system and unplug teh AC power

2. Remove DC IN power cable from DC IN power connector
3. Locate JCMOS1 and close pin 1-2 for few seconds

4. Return to default setting

5. Connect DC IN power cable back to DC IN Power connector

JCMOS1 | Description Note: Do not clear CMOS unless
*1-2 Normal set 1. Troubleshooting
short CMOS data clear 2. Forget password

Note: Normal work is open jumper 3. You fail over-clocking system

JCMOS1
123 123
*Normal CMOSs

21



2-11 COM port pin9 select Rl signal or Voltage source

JVC1: COM1 PIN9 select JVC2: COM2 PIN9 select
JVC3: COM3 PIN9 select  JVC4: COM4 PIN9 select
JVC5: COMS5 PIN9 select  JVC6: COM6 PIN9 select
JVC7: COM7 PIN9 select JVC8: COM8 PIN9 select
JVC9: COM9 PIN9 select  JVC10: COM10 PIN9 select

JVC1/2/3/4/5/6/7/8/9/10 DESCRIPION
*1-2 COM port pin9 use RI signal
3-4 COM port pin9 use +5V voltage
5-6 COM port pin9 use +12V voltage

Note: 1.Attention! Check Device Power in spec
2.1f want to use +5V/+12V need check system power design spec

[
<
Q
-

2 4 6 2 4 6 2 4 6
0O OO0 (OXOXO)
OO O OO0O0 O0oo
135 135 135
2 46 2 4 6 2 46
(OXOX@) [OXOJ@) (OXOXO)
Hjje)ye HjeJe) Ooo
135 135 135
Jvc2 +5V +12V
*RI Signal
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2-12 JVP1: LVDS panel Inverter power select

JVP1 | Description

1-2 +12V

*2-3 |5V

Note : Attention ! Check Device Power in spec.

JVP1

123 123
[Ooo]
+12V *+5V

2-13 JVL2: LVDS/eDP panel power select

JVL2 [ Description

1-2 | +3V

*.3 | +3.3V

Note : Attention ! Check Device Power in spec.

JVL2
12 3 123
+5V *+3.3V
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Chapter-3

Connection
This chapter provides all necessary information of the peripheral's connections,
switches and indicators. Always power off the board before you install the peripherals.

3-1 List of Connectors

CPI1: DC 12V-in DIN external connector (4pin mini din connector)
CPI112: DC-in 2x4 pin (2.00mm) Red wafer connector

DP1: Display Port

HDMI1: HDMI Connector

DVI1: DVI Connector

CC1&2/CC3&4: COM port DB9 Connector

CL4&5: LAN RJ45 connector

CUL2/CUL3: USB port 3.0/2.0 and LAN RJ45 connector

FAN1: Syatem Fan 1x3 pin (2.54mm) wafer

FAN2: CPU Fan 1x4 pin (2.54mm) wafer

CA1: Line-out/Line-in/Mic-in 2x5 pin (2.00mm) wafer

CAL1: Amplifier Line-out Left channel 2pin (2.00mm) wafer
CAR1: Amplifier Line-out Right channel 2pin (2.00mm) wafer
CL1: LAN1 2x4 pin (2.00mm) wafer

CL11: LAN1 LED 1x4 pin (1.25mm) wafer

CPP1: Panel inverter power connector 1x5 pin (2.00mm) wafer
CT1: Touch screen device 2x5 pin (2.00mm) Wafer

EDP1: eDP 2x10 pin (1.25mm) connector

LVDS1: LVDS 2x15 pin (1.25mm) connector

BAT1: Li 3V battery holder

MPCE1/MPCEZ2: Full size Mini card port sockets 52pin
SIM1/SIM2: SIM port 1/2 card socket

NGFF1: B Key Type 2242 size M.2 card Sockets

SATA1/2/3/4: SATA Connectors 7pin

CFP1: Front panel port 2x5 pin (2.00mm) wafer

SWP1: Power On/Off switch wafer

CIO1: DI port 0~3, DO port 0~3 2x5 pin (2.00mm) wafer

CIO2: DI port 4~7, DO port 4~7 2x5 pin (2.00mm) wafer
CU1/CU2/CU3/CU4/CU5: USB port 4pin (1.25mm) wafer
CPO1/CPO2: DC +5/+12V output 1x4 pin (2.00mm) Black wafer connector
CSP1/CSP2: DC +5V output 1x4 pin (2.00mm) Black wafer connector (Option)

___________________________________________________________________________|
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CO1:12C 4pin (1.25mm) wafer
CC5/CCB/CC7/CC8/CCY/CC10: COM 2x5pin (2.00mm) wafer
CKM1: KB/MS port 1x6 pin (1.25mm) wafer connector
SODIM1/ SODIM2: SO-DIM DDR4 1.2V DRAM Socket

3-2 DC 12V-IN external Connector

® CPI1: DC 12V-IN external Connector (4pin mini din connector)

PIN NO. | Description
1,2 +12V DC-IN
34 GND

Note: DC in from adapter plug in

® CPI12: DC-IN Internal Connector (2x4pin 2.0mm Red Wafer)

PIN NO. |Description PIN NO. |Description
1 GND 2 GND
3 DC-IN 4 DC-IN
5 DC-IN 6 DC-IN
7 GND 8 GND
Note:

1.DC in from adapter plug in

2.Share CPI1 Connector

3.Mating connector: JST B8B-PHDSS or compatible
4.Cable housing: JST PHDR-08VS or compatible

CPI12




3-3 Battery Input

e BAT1: 3V Battery hold 2pin
o BAT1: Battery use Li 3V/220mAh (CR2032)

BAT1

Note:

1. When board without Adaptor plug in, this board power RTC
consumption about 2.7uA

2. If adaptor always plug in RTC power consumption about 0.1uA

3-4 DC Power output

e CPO1/CPO2: +12V/+5V DC voltage output
(1 X 4 pin 2.00mm Black wafer)

PINNO  [DESCRIPTION
1 +5V
2 GND
3 GND
4 +12V *

Note: 1. DC in +12V by switch to DC-out voltage +12V, so DC in need stable +12V input
2. Mating connector: JST B4B-PH-KL or compatible
3. Cable housing: JST PHR-4 or compatible




e CSP1/CSP2: +5V DC voltage output (Option)

PIN NO DESCRIPTION
1 +5V
2 +5V
3 GND
4 GND

*Note: 1. Mating connector: JST B2B-PH-KL or compatible
2. Cable housing:JST PHR-2 or compatible

CSP1 CSP2

pin1 pin1
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3-5 Front panel & FAN

e CFP1 Front panel wafer
(2 X 5 pin 2.0mm wafer)

PIN NO. |DESCRIPTION PIN NO. DESCRIPTION
1 Power button GND 2 Power button pin
3 Reset GND 4 Reset pin
5 Power LED- 6 Power LED+
7 HDD LED- 8 HDD LED+
9 LAN LED- 10 LAN LED+

*Note: 1. Mating connector: JST B10B-PHDSS or compatible

2. Cable housing: JST PHDR-10VS or compatible

e SWP1 Power On/off switch Wafer
(1 X 2 pin 2.00mm wafer)

PIN NO. DESCRIPTION
1 Power button pin
2 Power button GND

*Note: 1. Mating connector: JST B2B-PH-KL or compatible
2. Cable housing: JST PHR-2 or compatible
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3-6 FAN connectors

e FAN1: System FAN Connector
(1 X 3 pin 2.54mm wafer)

PIN NO. | DESCRIPTION
1 GND
2 +12V
3 FAN speed detect

Note: 1. DC in +12V by switch to FAN power +12V, so DC in need stable +12V input
2. Mating connector: MOLEX 7879-3 or compatible
3. Cable housing: MOLEX 7880-3 or compatible

e FAN2: CPU FAN Connector
(1 X 4 pin 2.54mm wafer)

PIN NO. |DESCRIPTION
GND

+12V

FAN speed detect
4 FAN speed Control

WIN |~

Note: DC in +12V by switch to FAN power +12V, so DC in need stable +12V input

pin1

pin1
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3-7 Display & Touch interface
e DVI1: DVI-D 12bit connector Up side (DVI Connector)

PIN NO. | Description PIN NO. | Description PIN NO. | Description

1 Data 2- 9 Data 1- 17 Data 0-

2 Data 2+ 10 Data 1+ 18 Data 0+

3 GND 11 GND 19 GND

4 NC 12 NC 20 NC

5 NC 13 NC 21 NC

6 I°C-CLK 14 +5V 22 GND

7 I°C-DATA 15 GND 23 CLK+

8 NC 16 DVI-DETECT 24 CLK-

e DP1 : Display Port connector down side

PIN Description PIN Description
1 Lane 0+ 2 GND
3 Lane 0- 4 Lane 1+
5 GND 6 Lane 1-
7 Lane 2+ 8 GND
9 Lane 2- 10 Lane 3+
11 GND 12 Lane 3-
13 GND 14 GND
15 AUX_CH+ 16 GND
17 AUX_CH- 18 H.P. Detect
19 GND 20 +5V

« > — —_— _—

B ==

DP1
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3-8 HDMI interface

® HDMI1 : HDMI connector down side

PIN NO. [DESCRIPTION PIN NO. DESCRIPTION
1 TMDS DATA2+ 2 GND
3 TMDS DATA2- 4 TMDS DATA1+
5 GND 6 TMDS DATA1-
7 TMDS DATAO+ 8 GND
9 TMDS DATAO- 10 TMDS CLK+
11 GND 12 TMDS CLK-
13 NC 14 NC
15 DDC CLOCK 16 DDC DATA
17 GND 18 +5V
19 H.P. Detect
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3-9 EDP interface
® EDP1: eDP interface (2 X 10 pin 1.25mm wafer)

PIN NO. |DESCRIPTION PIN NO. |[DESCRIPTION

1 Lane 0- 2 +5V

3 Lane 0+ 4 +5V

5 Lane 1- 6 GND

7 Lane 1- 8 GND

9 ENBKL (3.3V) 10 GND

11 PWM dimming 12 GND

13 SMB_CLK 14 +LCD (5V or 3.3V)
15 SMB_DATA 16 +LCD (5V or 3.3V)
17 AUX_CH+ 18 +LCD (5V or 3.3V)
19 AUX_CH- 20 H.P. Detect

Note: 1. JVL2: eDP panel +5V/+3.3V Voltage select
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3-10 LVDS interface
® LVDS1: LVDS interface (2x15 pin 1.25mm wafer)

PIN NO. | Description PIN NO. | Description
1 PWM dimming 2 +5V
3 +LCD(5V or 3.3V) 4 +LCD(5V or 3.3V)
5 Channel-1-DATA3+ 6 Channel-0-DATA3+
7 Channel-1-DATA3- 8 Channel-0-DATA3-
9 Channel-0-DATA2+ 10 Channel-0-CLK+
1 Channel-0-DATA2- 12 Channel-0-CLK-
13 GND 14 GND
15 Channel-0-DATA1+ 16 Channel-0-DATAQO+
17 Channel-0-DATA1- 18 Channel-0-DATAO-
19 GND 20 GND
21 +LCD(5V or 3.3V) 22 +LCD(5V or 3.3V)
23 Channel-1-DATA2+ 24 Channel-1-CLK+
25 Channel-1-DATA2- 26 Channel-1-CLK-
27 Channel-1-DATA1+ 28 Channel-1-DATAO+
29 Channel-1-DATA1- 30 Channel-1-DATAOQ-

Note: 1. LVDS interface support 18/24bits two channel
2. JVL2: LVDS panel +5V/+3.3V Voltage select
3. LVDS1 PIN 1 for panel backlight active, Default active setup by DPC Control
4. Pin 1 back light dimming control. Provided 200Hz / 275Hz / 380Hz / 20KHz / 25KHz
And adjust PWM duty cycle by software program
5. Mating connector : HIROSE DF 13-30DS-1.25C or compatible
6. Cable housing : HIROSE DF13-30DP-1.25V or compatible




3-10-1 Panel Inverter power

® CPP1: Panel Inverter power (1 X 5 pin 2.0mm wafer)

PIN NO.

Description

+12V

GND

PWM dimming

ENBKL (3.3V)

Al |OWIN|~

ENBKL ( 5V )

Note : 1. JVP1 Inverter Voltage select
2. CPP1 PIN 3 and LVDS1 PIN1 is same signal. Default active setup by DPC Control
3. Pin 3 back light dimming Control. Provided 200Hz / 275Hz / 380Hz / 20KHz / 25KHz
And adjust PWM duty cycle by software program.
4. Mating connector: JST B5B-PH-KL or compatible
5. Cable housing: JST PHR-5 or compatible
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3-11 Touch screen device

® CT1: Touch screen (2x5 pin 2.0mm wafer)
Default use USB interface

® For 8-wire type pin define

PIN NO. | Description PIN NO. | Description
1 Bottom 2 Bottom Sense
3 Top Sense 4 Top
5 Right 6 Right Sense
7 Left 8 Left Sense
9 GND 10 N/A

Note : 1. For eight wire type cable Pin 3 and Pin4 need short.
2. Touch controller use USB port 8
3. Mating connector: JST B10B-PHDSS or compatible
4. Cable housing: JST PHDR-10VS or compatible

® For 4-wire type pin define

PIN NO. | Description PIN NO. | Description
1 Bottom 2 N/A
3 N/A 4 Top
5 Right 6 N/A
7 Left 8 N/A
9 GND 10 N/A

Note : 1. For four wire type cable Pin 3 and Pin4 need short.
2. Touch controller use USB port 8
3. Mating connector: JST B10B-PHDSS or compatible
4. Cable housing: JST PHDR-10VS or compatible

® For 5-wire type pin define

PIN NO. | Description PIN NO. | Description
1 UR(H) 2 N/A
3 Sense 4 UL(Y)
5 LR(X) 6 N/A
7 LL(L) 8 N/A
9 GND 10 N/A

Note: 1. Touch controller use USB port 8
2. Mating connector: JST B10B-PHDSS or compatible
3. Cable housing: JST PHDR-10VS or compatible

36




10

3-12 Audio interface
® CA1: Line-out/Line-in/Mic-in (2 X 5 pin 2.00mm wafer)

PIN NO. | Description PIN NO. | Description
1 Line-out-R 2 MIC-IN
3 Line-in-R 4 GND
5 GND 6 NC
7 Line-in-L 8 +5V
9 Line-out-L 10 MIC-IN

Note: 1. Mating connector: JST B10B-PHDSS or compatible
2. Cable housing: JST PHDR-10VS or compatible

CA1
pin1

10
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® CAR1: Audio Ampilifier Line out Right
(1 X 2 pin 2.00mm wafer)

PIN NO. DESCRIPTION
1 LINE-OUT_R+
2 LINE-OUT_R-

Note: 1. Mating connector: JST B2B-PH-KL or compatible
2. Cable housing: JST PHR-2 or compatible

® CAL1: Audio Amplifier Line out Left
(1 X 2 pin 2.00mm wafer)

PIN NO. DESCRIPTION
1 LINE-OUT_L+
2 LINE-OUT_L-

Note: 1. Mating connector: JST B2B-PH-KL or compatible
2. Cable housing: JST PHR-2 or compatible

pin1 pin1
| |
ol of

CAL1 CAR1
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3-13 /0 Interface

® COM ports
COM1/2/4/5/6/7/8/9/10 default support RS232/RS422/RS485 mode

® RS232 mode ports (D-SUB 9pin)
CC1&2: COM1 (up side)/COM2 (down side) port connector
CC3&4: COM3 (up side)/COM4 (down side) port connector

PIN NO. | Description PIN NO. | Description
1 DCD 2 RXD
3 TXD 4 DTR
5 GND 6 DSR
7 RTS 8 CTS
9 RI/Voltage

Note: 1. Pin 9 Rl and Voltage setting only for COM 1/2/3/4 ports
JVC1 for COM1,JVC2 for COM2 , JVC3 for COM3,JVC4 for COM4
2. default support RS232/RS422/RS485 by BIOS selected

® RS485 mode ports (D-SUB 9pin)
CC1&2: COM1 (up side)/COM2 (down side) port connector
CC3&4: COM3 (up side)/COM4 (down side) port connector

PIN NO. | Description PIN NO. | Description
1 RS485 TX- 2 RS485 TX+
3 NC 4 NC
5 GND 6 NC
7 NC 8 NC
9 NC

Note: 1. BIOS need setting to RS485 mode

® RS422 mode ports (D-SUB 9pin)
CC1&2: COM1 (up side)/COM2 (down side) port connector
CC3&4: COM3 (up side)/COM4 (down side) port connector

PIN NO. | Description PIN NO. | Description
1 RS422 TX- 2 RS422 TX+
3 RS422 RX+ 4 RS422 RX-
5 GND 6 NC
7 NC 8 NC
9 NC

Note: 1. BIOS need setting to RS422 mode
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CcomM1 com3

COom2 com4

® RS232 mode ports (2 X 5 pin 2.00mm wafer)
CC5: COM5 CC6 : COM6
CC7: COM7 CC8: COM8
CC9: COM9 CC10: COM10

PIN NO. | Description PIN NO. | Description
1 DCD 2 RXD
3 TXD 4 DTR
5 GND 6 DSR
7 RTS 8 CTS
9 RI/Voltage 10 +5V

Note: 1. Pin 9 Rl and Voltage setting only for COM 5/6/7/8/9/10 ports
JVC5 for COMS5, JVC6 for COMS6, JVC7 for COM7, JVC8 for COM8, JVC9 for
COM9, JVC10 for COM10

. default support RS232/RS422/RS485 by BIOS selected

. Mating connector: JST B10B-PHDSS or compatible

. Cable housing: JST PHDR-10VS or compatible

A WOWN

® RS485 mode ports (2 X 5 pin 2.00mm wafer)
CC5: COM5 CC6 : COM6
CC7: COM7 CC8: COM8
CC9: COM9 CC10: COM10

PIN NO. | Description PIN NO. | Description
1 RS485 TX- 2 RS485 TX+
3 NC 4 NC
5 GND 6 NC
7 NC 8 NC
9 NC 10 +5V

Note: 1. BIOS need setting to RS485 mode
2. Mating connector: JST B10B-PHDSS or compatible
3. Cable housing: JST PHDR-10VS or compatible

40



® RS422 mode ports (2 X 5 pin 2.00mm wafer)
CC5: COM5 CC6 : COM6
CC7: COM7 CC8: COM8
CC9: COM9 CC10: COM10

PIN NO. | Description PIN NO. | Description
1 RS422 TX- 2 RS422 TX+
3 RS422 RX+ 4 RS422 RX-
5 GND 6 NC
7 NC 8 NC
9 NC 10 +5V

Note: 1. BIOS need setting to RS422 mode
2. Mating connector: JST B10B-PHDSS or compatible
3. Cable housing: JST PHDR-10VS or compatible

CC5Cc6CC7CCB8CCI9CC10

pin1
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3-14 Digital Input / Output / Watch Dog Time
oClO1 DIO 0 ~ 3 (2x5pin 2.0mm wafer)

PIN NO. | Description PIN NO. | Description
1 DI-0 2 DO-3
3 DI-1 4 DO-2
5 DI-2 6 DO-1
7 DI-3 8 DO-0
9 GND 10 +5V

Note: 1. DI pin default pull up 10KQ to +5V
2. If use need isolate circuit to control external device
3. F75111N-1 I°C bus address 0x9c
4. Mating connector: JST B10B-PHDSS or compatible
5. Cable housing: JST PHDR-10VS or compatible

® ClO2 DIO 4 ~ 7 (2x5pin 2.0mm wafer)

PIN NO. | Description PIN NO. | Description
1 DI-4 2 DO-7
3 DI-5 4 DO-6
5 DI-6 6 DO-5
7 DI-7 8 DO-4
9 GND 10 +5V
Note: 1. DI pin default pull up 10KQ to +5V Clo2
2. If use need isolate circuit to control external device o m |pint
3. F75111N-1 I°C bus address 0x9c i
4. Mating connector: JST B10B-PHDSS or compatible oo
5. Cable housing; JST PHDR-10VS or compatible 1000
o m |pint
o0
LN ]
® For F75111N I°C watch dog timer device: olee
DC spec: clo1

Input low Voltage (VIL): +0.8 Max

Input High Voltage (VIH): +2V Min

Output low Current (IOL): 10mA (Min) VOL=0.4V

Output High Current (IOH): -10mA (Min) VOH=2.4V

Watch Dog Time value 0~255 sec

The system will be issued reset. When WDT is enable the
hardware start down counter to zero. The reset timer have
10~20% tolerance upon the Temperature.

Note: If want to SDK support. Please contact to sales window.
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3-8-1 10 Device: F75111 under DOS

The Sample code source you can download from

Source file: F75111_Dos_Src.rar http://tprd.info/lexwiki/index.php/IO_Device:F75111_under_DOS
Binary file: F75111_Dos_Bin.rar

USERNAME & PASSWORD: sf

How to use this Demo Application

1.Boot Ms-Dos Operating System
2.execute "75WDT.EXE" binary file
3.Input 1 to Enable WDT timer or input 0 to Disable it.

4.input numbers of second for chip countdown and Reset Computer

if there's no disable signal

5

{ F75111 WDT }——Enablesignal———w/\\
r

if there's disable signal

b

Disable signal

F75111 Layout Picture

EaE I2C address:
R HC: 0X9C
M wal RA 0K: 0%6E
MCHOK] 4

1
3

E From systemi
\ SM BUS !

BOI0/GPIOT4/LED |2
BOI1/GRIOT7/LED |5
BOIZ/GRI0NE/LED s
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BOKYGRIOI |53
BOISARI03E |53
BOIG/GRI03: e
BOITIGRIN18/LED —

WEBI

SMB_CLE >>—f% SCLK 4DT

ShiB_DATA >———— SDATA

aDT

] (2 o Fct et (=

o ||| | o o | o e
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e BOO3/GPI0E7/LED
G R e et i T BOO4/GFI026/LED
+ To platfrom ; BD05/GFID25/LED
¢ Reset | w——— GRIO11/LED BOOG/GFI024/LED
i o BOOF/GFI0ZHLED —=
L OMDT_RET- <4 T GPIOIDALEDANDTOUT2H

WOT DO0 12

Loel Gl =

Oo2 4D0
e 8DO

L1 [

B [~ e E B

| || | @ |
Le=]
[l
b

GRIOZLEDVIR AOTOLTI 18

[ [RET Tk fied o R

___________________________________________________________________________|
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Introduction
How to use this Demo Application

Writel2CByte(I2CADDR, CONFIG, 0x03);//Set Watch Dog Timer function :
Writel2CByte(I2CADDR, WDT_TIMER, timer);//Set Watch Dog Timer range from 0-255. :
Writel2CByte(I2CADDR, WDT_TIMER_CTL, 0x73);//Enable Watch Dog Timer in second and pulse mode :

How to use this Demo Application
Writel2CByte(I2CADDR, WDT_TIMER_CTL, 0x00); .
How to use this Demo Application
void pause(int time)
{

asm mov ah,0h; //Ah =00 Read System Time Counter
asm int 1ah; /Iread time from Time Counter and store it in DX register
asm add dx,time;

label:
asm int 1ah;
asm cmp bx,dx;

1 1
1 1
1 1
1 1
1 1
1 1
1 1
1 1
1 1
1 1
1 asm mov bx,dx; 1
1 1
1 1
1 1
1 1
1 1
1 1
1 . 1
' asm jne label; '
1 1
1 1
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3-8-2 10 Device: F75111 under Windows

The Sample code source you can download from

Source file: F75111_DIO_Src_v2.8W(32bit).zip http://tprd.info/lexwiki/index.php/IO_Device:F75111
Binary file: F75111_DIO_Bin_v2.8W(32bit).zip

USERNAME & PASSWORD: sf

We do the demo test with a test tool which DIx connect to DOx with Relay.
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How to use this Demo Application

one F75111 two F75111
- FI3171, 0 « FIS111vi6W
Castomize 75111 Addsess Cuinenizs 15111 Address
Inpui yeur cesiomize sddreasl [® Teput your ciatienize addres=] - Obe| 1M
Triput your custtomies sddmes - One| 6
0 Tast DO Test
@ yoo TESTHE e - @ DuDol TESTED ...
LT TR T — - @ DLDOL TESTEON .o,
L) @ DLDO TEST2ED)
o @ DLDO TEST20LO)

7 8 5 a 3 2 1 L] T 8 5 4 3 2 1 0
toisus @ @ @ @ O 0 @ O e @ @ 0 @ @ @ @
hsews @ @ @ @ @ @ @ O mamn: @ @ @ 0 @ @ @ @

[ o B o T o T o o Tl e @ @ @ @ @ @ @ @

Q89 B 8 g & B mziens: @ @ @ @ @ @ @ @

e ] _ Swa |
WWOT Test WDT Test
Enable | " | Enable 0
™ Ennble Losp Instsll WOT | 5 Bsillatony Insisll HOT

Attention Please: You must be install vcredist_x86.exe when first time you run the
F75111_DIO.exe DEMO AP, The vcredist_x86.exe include all required DLL file.
WARNING: win7 system architecture, use the system administrator to open DIO utility

1. Press the "Start" button to test DIO function

2. Press the "Enable" button to test WDT function

3. Press the "Disable" button to disable WDT

4. Check the "Enable Loop" box and press "Enable" to do WDT loop test

5. Press "Install WDT" to set the system to autorun this application when booting,
press again to remove this application when booting.

6. If WDT enable, system icon will be. if disable, system icon will be
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if there's no disable signal

S

[ Frs111 wor %——Enablesignal———w/

r

\/

if there's disable signal

Disable signal

p.s.
75111 send "F75111_SetWDTEnable(BYTE byteTimer)" including a parameter "timer",

if there's no disable signal (F75111_SetWDTDisable()) to stop it before timer countdown to 0, System will reboot.
if there's disable signal received, resent Enable WDT signal, for a loop to prevent from reboot

F75111 Layout Picture

SEAE I2C address:

Rty HC: 0X9C

M sl RA  J0K: 0%6E
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1
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8DI
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||| | o | o
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D00
O

Oz
T 1%

D04

s EDO
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WOT Tt 1z

=1

P |
| o =
o || | || oo

GPRIOTZLEDARQANDTOUTI 14

DIOAWDTORF NE)

Introduction

: define GPIO1X, GP102X, GPIO3X to input or output
1 and Enable WDT function pin

: DO: InterDigitalOutput(BYTE byteValue))
1 DI: InterDigitallnput()



Enable/Disable WDT

: Enable : F75111_SetWDTEnable (BYTE byteTimer) :
1 Disable: F75111_SetWDTDisable () 1
PULSE mode

Sample to setting GP33, 32, 31, 30 output 1mS low pulse signal.

L el §
"

this->Write_Byte(F75111_INTERNAL_ADDR, GPIO3X_PULSE_CONTROL, 0x00); //This is setting low pulse output
this->Write_Byte(F75111_INTERNAL_ADDR, GPIO3X_PULSE_WIDTH_CONTROL, 0x01); //This selects the pulse width to 1mS
this->Write_Byte(F75111_INTERNAL_ADDR, GPIO3X_CONTROL_MODE, 0xOF); //This is setting the GP33, 32, 31, 30 to output function.
this->Write_Byte(F75111_INTERNAL_ADDR, GPIO3X_Output_Data , OxOF); //This is setting the GP33, 32, 31, 30 output data.

1}

Initial internal F75111

: void F75111::InitinternalF75111() :
1 { 1
1 1
1 this->Write_Byte(F75111_INTERNAL_ADDR,GPIO1X_CONTROL_MODE ,0x00);  //set GPIO1X to Input function 1
: this->Write_Byte(F75111_INTERNAL_ADDR,GPIO3X_CONTROL_MODE ,0x00);  //set GPIO3X to Input function :
V' this->Write_Byte(F75111_INTERNAL_ADDR,GPIO2X_CONTROL_MODE ,0xFF);  //set GPIO2X to Output function !
1 1
1 1
1 1
1 this->Write_Byte(F75111_INTERNAL_ADDR,F75111_CONFIGURATION, 0x03); /IEnable WDT OUT function 1
1 1
1 } 1
B o e e o e e o e e o e e e R e e e R R e R R e R R R R R R e R R R R R R R R R e R R R e R R e R e e e e e e e o e o

Set output value

1 void F75111::InterDigitalOutput(BYTE byteValue)
{
BYTE byteData = 0;
byteData = (byteData & 0x01 )? byteValue + 0x01 : byteValue;
byteData = (byteData & 0x02 )? byteValue + 0x02 : byteValue;
byteData = (byteData & 0x04 )? byteValue + 0x04 : byteValue;
byteData = (byteData & 0x80 )? byteValue + 0x08 : byteValue;

byteData = (byteData & 0x20 )? byteValue + 0x20 : byteValue;
byteData = (byteData & 0x10 )? byteValue + 0x40 : byteValue;

byteData = (byteData & 0x08 )? byteValue + 0x80 : byteValue; 1/ get value bit by bit

this->Write_Byte(F75111_INTERNAL_ADDR,GPIO2X_OUTPUT_DATA byteData); // write byteData value via GPIO2X output pin

}

1
1
1
1
1
1
1
1
1
1
1
1

byteData = (byteData & 0x40 )? byteValue + 0x10 : byteValue; :
1
1
1
1
1
1
1
1
1
1
a
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Get Input value

1 BYTE F75111::InterDigitallnput()
{
BYTE byteGPIO1X = 0;
BYTE byteGPIO3X = 0;
BYTE byteData =0;

byteGPIO1X = byteGPIO1X & OxFO;
byteGPIO3X = byteGPIO3X & OxOF;

return byteData;

1}

Enable WatchDog

1 void F75111_SetWDTEnable (BYTE byteTimer)
{

}

Disable WatchDog

! void F75111_SetWDTDisable ()
{

1}

define F75111 pin in F75111.h

byteData = ( byteGPIO1X & 0x10 )? byteData + 0x01 :
byteData = ( byteGPIO1X & 0x80 )? byteData + 0x02 :
byteData = ( byteGPIO1X & 0x40 )? byteData + 0x04 :
byteData = ( byteGPIO3X & 0x01 )? byteData + 0x08 :

byteData = ( byteGPIO3X & 0x02 )? byteData + 0x10 :
byteData = ( byteGPIO3X & 0x04 )? byteData + 0x20 :
byteData = ( byteGPIO3X & 0x08 )? byteData + 0x40 :
byteData = ( byteGPIO1X & 0x20 )? byteData + 0x80 :

this->Read_Byte(F75111_INTERNAL_ADDR,GPIO1X_INPUT_DATA &byteGPIO1X) ; // Get value from GPIO1X
this->Read_Byte(F75111_INTERNAL_ADDR,GPIO3X_INPUT_DATA &byteGPIO3X) ; // Get value from GPIO3X

/I Mask unuseful value

/I Mask unuseful value

byteData;
byteData;
byteData;
byteData;

byteData;
byteData;
byteData;
byteData; /I Get correct DI value from GPIO1X & GPIO3X

WriteByte(F75111_INTERNAL_ADDR,WDT_TIMER_RANGE ,byteTimer); /I set WatchDog range and timer
WriteByte(F75111_INTERNAL_ADDR,WDT_CONFIGURATION,WDT_TIMEOUT_FLAG | WDT_ENABLE | WDT_PULSE | WDT_PSWIDTH_100MS);

/I Enable WatchDog, Setting WatchDog configure

WriteByte(F75111_INTERNAL_ADDR,WDT_CONFIGURATION,0x00); // Disable WatchDog

1
1 #define  F75111_INTERNAL_ADDR
1
#define F75111_EXTERNAL_ADDR

0x9C // OnBoard F75111 Chipset
O0x6E // External F75111 Chipset

#define  F75111_CONFIGURATION

1
1
1
1
1

I
1

0x03 // Configure GPIO13 to WDT2 Function

: #define GPIO1X_CONTROL_MODE
1 #define  GPIO2X_CONTROL_MODE
1

1 #define  GPIO3X_CONTROL_MODE

0x10 // Select Output Mode or Input Mode
0x20 // Select GPIO2X Output Mode or Input Mode
0x40 // Select GPIO3X Output Mode or Input Mode
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/I 0:Level Mode
/I 1:Pulse Mode

#define WDT_UNIT 0x08 // Watchdog unit select.
/I 0:Select second.

1
1
1
1
1
1
1
1
1 /I 1:Select minute.
1
1
1
1
1
1
1
1

1
1 1
1 #define  GPIO1X_INPUT_DATA 0x12 /I GPIO1X Input 1
: #define  GPIO3X_INPUT_DATA 0x42 // GPIO3X Input :
1/ 1
: #define  GPIO2X_OUTPUT_DATA 0x21 // GPIO2X Output :
(W 1
1
f #define GPIO1X_PULSE_CONTROL 0x13 // GPIO1x Level/Pulse Control Register :
1 /I 0:Level Mode !
1 1
1 /I 1:Pulse Mode 1
I #define  GPIO1X_PULSE_WIDTH_CONTROL 0x14 // GPIO1x Pulse Width Control Register !
1 1
1 #define GP1_PSWIDTH_500US 0x00 // When select Pulse mode: 500 us. 1
: #define GP1_PSWIDTH_1MS 0x01 // When select Pulse mode: 1 ms. :
1 #define GP1_PSWIDTH_20MS 0x02 // When select Pulse mode: 20 ms. 1
: #define GP1_PSWIDTH_100MS 0x03 // When select Pulse mode: 100 ms. :
(W 1
1
f #define GPIO2X_PULSE_CONTROL 0x23 // GPIO2x Level/Pulse Control Register :
! /I 0:Level Mode 1
1 1
1 /I 1:Pulse Mode N
! #define GPIO2X_PULSE_WIDTH_CONTROL 0x24 /I GPIO2x Pulse Width Control Register !
1 1
| #define GP2_PSWIDTH_500US 0x00 // When select Pulse mode: 500 us. 1
: #define GP2_PSWIDTH_1MS 0x01 // When select Pulse mode: 1 ms. :
1 #define GP2_PSWIDTH_20MS 0x02 // When select Pulse mode: 20 ms. 1
: #define GP2_PSWIDTH_100MS 0x03 // When select Pulse mode: 100 ms. :
L/ 1
1 1
f #define GPIO3X_PULSE_CONTROL 0x43 // GPIO3x Level/Pulse Control Register f
! /I 0:Level Mode 1
1 1
1 /I 1:Pulse Mode 1
I #define  GPIO3X_Output_Data 0x41 // GPIO3x Output Data Register 1
1 1
1 #define  GPIO3X_PULSE_WIDTH_CONTROL 0x44 /I GPIO3x Pulse Width Control Register 1
: #define GP3_PSWIDTH_500US 0x00 // When select Pulse mode: 500 us. :
1 #define GP3_PSWIDTH_1MS 0x01 // When select Pulse mode: 1 ms. 1
: #define GP3_PSWIDTH_20MS 0x02 // When select Pulse mode: 20 ms. :
1 #define GP3_PSWIDTH_100MS 0x03 // When select Pulse mode: 100 ms. 1
L 1
1 1
I #define WDT_TIMER_RANGE 0x37 /I 0-255 (secord or minute program by WDT_UNIT) 1
1 1
) #define  WDT_CONFIGURATION 0x36 // Configure WDT Function 1
! #define WDT_TIMEOUT_FLAG 0x40 // When watchdog timeout.this bit will be set to 1. !
1 1
| #define  WDT_ENABLE 0x20 // Enable watchdog timer 1
: #define WDT_PULSE 0x10 // Configure WDT output mode :
1
1
1
1
1
1
1
1
1
1
1
#define WDT_LEVEL 0x04 // When select level output mode: 1
/I 0:Level low :
/I 1:Level high 1
1
1
I #define WDT_PSWIDTH_1MS 0x00 // When select Pulse mode: 1 ms. 1
1 1
1 #define WDT_PSWIDTH_20MS 0x01 // When select Pulse mode: 20 ms. f
I #define  WDT_PSWIDTH_100MS 0x02 // When select Pulse mode: 100 ms. 1
1 1
| #define  WDT_PSWIDTH_4000MS 0x03 // When select Pulse mode: 4 s. 1
4

___________________________________________________________________________|
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3-8-3 10 Device: F75111 VB6 under Windows

The Sample code source you can download from

Source file: 75111_VB_v1.2.rar http://tprd.info/lexwiki/index.php/IO_Device:F75111_VB6
Binary file: 75111_VB_Src1.2.rar

USERNAME & PASSWORD: sf

How to use this Demo Application

- ™

5y 75111 DEMO VBwv1 2 (== =]

For CI770 ClE50 For 31380

CIB47 Series BayTrail Series Legacy Series

Flease key-in the timer by secll

Flease key-inthe DO Value by hex |l exp:0xFF = FF

Push the Button will show the DI Yalue 1l

1% Walue

e A Function - Choose your motherboard model

e B Function - Enable WDT timer ,Key-in the value by seconds then system will reboot after
value which you key-in in left text box !!

e C Function - Disable WDT timer ,Push down the button then WDT timer value will be clear !!

e D Function - Set DO Value ,Key-in the DO value by hex then push the button !!

e E Function - Check DI Value ,The right side two text box will display DI 1X & 2X Value when

you push down the button!!
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F75111 Layout Picture

I I2C address:
R RA HC: 0X9C
__._L”M._ 10K: 0X6E
E NCA10K] 4
: i = n e
 From system, q AO0
. SM BUS | § £ BOVGRIOIHLED |5 RO
: ; BOI1/GRIO7/LED
booawe cueoy——H o % 2 BDI/GPIOGILED e DL 4pT
' SnB_DATA — SOATA o BOI/GRI030 g e
Lot B ' o BOIGRIOH |53 =t 8DI
= BOIS/GRI032 55 Tl
= BOIG/GRI02E 75 il
%  BOIWGPIOISLED
19 6np BDoD/GPI0z0/LED | SLat
BOO1/GRIOZ1/LED
M bGnD BDOGPIOZZ/LED |7 fLe 4Do
A BOOGRIOZZ/LED g BT
prmmmmememe ool : BOO4/GRI0ZE/LED f3 Tl 8D0
+ To platfram ; BDOS/GPIOZS/LED f7 T
. Reset 1 %¥——— GRIOT1/LED BDOB/GPIOZHLED 5 TiH
; e BOO7/GRIOZI/LED
! WIDT_RST- £¢ " GPIOT0/LEDAVDTOUTZH
QOT D00 12 3 Gipy 012/ EAR QAWDTO LT 14

CTOAWDTCLF N

SDK Function Introduction

: Function EnableWDT(timer As Integer)

1

: Call Writel2CByte(&H3, &H3)

: Call Writel2CByte(&H37, timer)

: Call Writel2CByte(&H36, &H73)

1
: End Function

! Function DisableWDT()

1
1 Call Writel2CByte(&H36, &H0)

1
: End Function
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: Function SetDOValue(dovalue As Integer)

: Dim Data As Integer

: Dim Value As Integer

1

1

1Data=0

: Value = dovalue

1

1

1 If (Value And &H1) <> 0 Then

1

1 Data = Data + &H1

VEnd If

If (Value And &H2) <> 0 Then
Data = Data + &H2

End If

If (Value And &H4) <> 0 Then
Data = Data + &H4
End If

If (Value And &H80) <> 0 Then
Data = Data + &H8
End If

If (Value And &H40) <> 0 Then
Data = Data + &H10
End If

If (Value And &H20) <> 0 Then
Data = Data + &H20
End If

If (Value And &H10) <> 0 Then
Data = Data + &H40
End If

If (Value And &H8) <> 0 Then
Data = Data + &H80

1 End If

1

: Call Writel2CByte(&H23, &HO0)

1 Call Writel2CByte(&H20, &HFF)
(
(

! Call Writel2CByte(&H2B, &HFF)

: Call Writel2CByte(&H21, Data)
1
: End Function



1 Function CheckDIValue()

1 Dim GPIO1X  As Integer
1 Dim GPIO3X  As Integer
1 Dim DI1Xhex As String

1 Dim DI3Xhex  As String

1

: Dim Data As Long
1

1
1Data=0
1

1

1 Call Readl2CByte(&H12, GPIO1X)

: Call Readl2CByte(&H42, GPIO3X)

1

: GPIO1X = GPIO1X And &HFO

: GPIO3X = GPIO3X And &HF

1

: If (GPIO1X And &H10) <> 0 Then

1 Data = Data + &H1

VEnd If

If (GPIO1X And &H80) <> 0 Then
Data = Data + &H2

End If

If (GPIO1X And &H40) <> 0 Then
Data = Data + &H4
End If

If (GPIO3X And &H1) <> 0 Then
Data = Data + &H8
End If

If (GPIO3X And &H2) <> 0 Then
Data = Data + &H10
End If

If (GPIO3X And &H4) <> 0 Then
Data = Data + &H20
End If

If (GPIO3X And &H8) <> 0 Then
Data = Data + &H40
End If

If (GPIO1X And &H20) <> 0 Then
Data = Data + &H80
End If

DI1Xhex = Hex(Data)

: Text3.Text = "0x" + DI1Xhex
1

: End Function



e
3-8-4 10 Device: F75111 under linux

The Sample code source you can download from
Source file: F75111v2.4L_SRC.tar.gz http://tprd.info/lexwiki/index.php/IO_Device:F75111_under_linux
Binary file: F75111v2.4L_BIN.tar.gz
USERNAME & PASSWORD: sf
How to compile source code
1. Compile source code with Code::Blocks
download and install the Code::Block with command "apt-get install codeblocks"
Open an exist project(F75111.cbp) in Code::Blocks, click the compile button
( add an option 'pkg-config --libs gtk+-2.0 gthread-2.0' in "Project->Build Option-
>Linker Setting->Other linker option™)
2. Compile source code with "make"
1. cd F75111
1. make
1. src/f75111 /| execute the binary file

How to use this Demo Application

S F75111v23L

Customize F75111 Address: 0x |9C

DIO Teskt
DI/DOTest(LowW) ...coomennnees 0%

DI/ DO Test (High) ..ccoceen.ca 0%

76 5 4 32 71 0

DO Status
Dl Status
| Start |
WDT Test
| Enable | |10 Disable
Enable Loop Test | Install |
WDTStand by ....eveveneeees \Uninskall)

___________________________________________________________________________|
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1. Press the "Start" button to test DIO function

2. Press the "Enable" button to test WDT function

3. Press the "Disable" button to disable WDT

4. Check the "Enable Loop" box and press "Enable" to do WDT loop test

5. Press "Install” to set the system to autorun this application when booting,
press "Uninstall" to remove this application when booting.

6. If WDT enable, system icon will be blinking.

if there's no disable signal

*

} P75 wor %P—Enablesignal———m/

o

b £

if there's disable signal

Disable signal

p.s.
75111 send "F75111_SetWDTEnable(BYTE byteTimer)" including a parameter "timer",

if there's no disable signal (F75111_SetWDTDisable()) to stop it before timer countdown to 0, System will reboot.
if there's disable signal received, resent Enable WDT signal, for a loop to prevent from reboot p.s.

F75111 Layout Picture

Aaas I2C address:
RA HC: DX9C
ohit el RA 10K: O0X6E
HCHDE] 4

E From systemi
\ SM BUS '
b e ik yy——1

L] 5] SCLE
Shi_GaTa > SOATA

BON/ASPIOT7/LED

BOIZAGRIOTE/LED |
BOI3/GRIDG g
e
BOIS/GPIOSE |5
BOIB/GPIOZS |-y

BOIFASRIOT5/LED

BOIDSGPIOT4YLED g
4 4DI

8DI

| oo o | o o e e |
b F=5) i e ] =

GPRION3N2C_ADDR

GHD BOO0SGRI0Z0VLED
1t BOO1SGRIOZ/LED
GHD BOOZ/GRIDZZ/LED

22 4po
— 8D0

" BO03/GPIOZT/LED
fmmmmm e emmm o] ] BO04/GRI0ZE/LED
v To platfrom |, 1 BOOS/GRI02E/LED
: Reset i GPIOT1/LED BOOGIGPI02HLED
§ Y BOO7/GRI0/LED
! MDT_RST- <4 ; GRIO10/LED ADTOUT2H

WOT Do 12

b
pae [ 3 = = |
||| | | o f |

o)

]

|

GRIONZALED/IR 2ADOTO LT 14

DTOADTF Nz

___________________________________________________________________________|
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Introduction

: void SMBusloWrite(BYTE byteOffset,BYTE byteData)

outb( byteData , m_SMBusMaploAddr + byteOffset);

BYTE SMBusloRead(BYTE byteOffset)
{
DWORD dwAddrVal;

dwAddrVal = inb(m_SMBusMaploAddr + byteOffset);
return (BYTE)(dwAddrVal & 0xOFF);

1
1
1
1
this->Write_Byte(F75111_INTERNAL_ADDR,GPIO1X_CONTROL_MODE ,0x00); /Iset GPIO1X to Input function 1
this->Write_Byte(F75111_INTERNAL_ADDR,GPIO3X_CONTROL_MODE ,0x00); /Iset GPIO3X to Input function :
1
1
1
1
1
1
1

this->Write_Byte(F75111_INTERNAL_ADDR,F75111_CONFIGURATION, 0x03); /[Enable WDT OUT function

1
1
1
1
1
1
1
: this->Write_Byte(F75111_INTERNAL_ADDR,GPI02X_CONTROL_MODE ,0xFF); /Iset GP102X to Output function
1
1
1
1
1

Set output value

:void F75111::InterDigitalOutput(BYTE byteValue)

BYTE byteData = 0;

byteData = (byteData & 0x01 )? byteValue + 0x01 : byteValue;

byteData = (byteData & 0x02 )? byteValue + 0x02 : byteValue;

byteData = (byteData & 0x04 )? byteValue + 0x04 : byteValue;

byteData = (byteData & 0x80 )? byteValue + 0x08 : byteValue;

byteData = (byteData & 0x40 )? byteValue + 0x10 : byteValue;

byteData = (byteData & 0x20 )? byteValue + 0x20 : byteValue;

byteData = (byteData & 0x10 )? byteValue + 0x40 : byteValue;

byteData = (byteData & 0x08 )? byteValue + 0x80 : byteValue; /I get value bit by bit

this->Write_Byte(F75111_INTERNAL_ADDR,GPIO2X_OUTPUT_DATA,byteData); // write byteData value via GPIO2X output pin
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Get Input value

: BYTE F75111::InterDigitallnput()

At

BYTE byteGPIO1X = 0;
BYTE byteGPIO3X = 0;
BYTE byteData = 0;

this->Read_Byte(F75111_INTERNAL_ADDR,GPIO1X_INPUT_DATA, &byteGPIO1X) ; // Get value from GPIO1X
this->Read_Byte(F75111_INTERNAL_ADDR,GPIO3X_INPUT_DATA &byteGPIO3X) ; // Get value from GPIO3X

byteGPIO1X = byteGPIO1X & OxFO;
byteGPIO3X = byteGPIO3X & Ox0F;

byteData = ( byteGPIO1X & 0x10 )? byteData + 0x01

byteData = ( byteGPIO1X & 0x80 )? byteData + 0x02 :
byteData = ( byteGPIO1X & 0x40 )? byteData + 0x04 :
byteData = ( byteGPIO3X & 0x01 )? byteData + 0x08 :

byteData = ( byteGPIO3X & 0x02 )? byteData + 0x10 :
byteData = ( byteGPIO3X & 0x04 )? byteData + 0x20 :
byteData = ( byteGPIO3X & 0x08 )? byteData + 0x40 :
byteData = ( byteGPIO1X & 0x20 )? byteData + 0x80 :

return byteData;

: void F75111_SetWDTEnable (BYTE byteTimer)

I

WriteByte(F75111_INTERNAL_ADDR,WDT_TIMER_RANGE ,byteTimer);

: byteData;
byteData;
byteData;
byteData;

byteData;
byteData;
byteData;
byteData;

/I Mask unuseful value
/I Mask unuseful value

/I Get correct DI value from GPIO1X & GPIO3X

/I set WatchDog range and timer

WriteByte(F75111_INTERNAL_ADDR,WDT_CONFIGURATION,WDT_TIMEOUT_FLAG | WDT_ENABLE | WDT_PULSE | WDT_PSWIDTH_100MS);

. v0|d F75111_SetWDTDisable ()

"

WriteByte(F75111_INTERNAL_ADDR,WDT_CONFIGURATION,0x00);
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1y

1
1 #define F75111_INTERNAL_ADDR
: #define F75111_EXTERNAL_ADDR

11/

0x9C
Ox6E

: #define F75111_CONFIGURATION
1

0x03

1
| #define GPIO1X_CONTROL_MODE
! #define GPI02X_CONTROL_MODE

1
| #define GPIO3X_CONTROL_MODE
Iy

0x10
0x20
0x40

1
1 #define GPIO1X_INPUT_DATA
: #define GPIO3X_INPUT_DATA

1/

0x12
0x42

1
| #define GPIO2X_OUTPUT_DATA
L

0x21

1
| #define GPIO2X_OUTPUT_DRIVING
1

0x2B

1
1 #define WDT_TIMER_RANGE
1

0x37

1

1 #define WDT_CONFIGURATION
1 #define WDT_TIMEOUT_FLAG
1 #define WDT_ENABLE

1

| #define WDT_PULSE

1

1

1

: #define WDT_UNIT

1

1

1

1 #define WDT_LEVEL

1

1

1

1

| #define WDT_PSWIDTH_1MS

| #define WDT_PSWIDTH_20MS
1 #define WDT_PSWIDTH_100MS
1 tdefine WDT_PSWIDTH_4000MS

1/

0x36
0x40

1

1 typedef struct F75111_Address
R

1

1 BYTE bAddress;

: JF75111_Address;

1 F75111_Address m_F75111;
1
1

1 bool F75111_Init();

: BYTE F75111_GetDigitallnput ();

1 void F75111_SetDigitalOutput(BYTE byteValue);
1

1

: BYTE F75111_GetWDTMode();

1 void F75111_SetWDTMode(BYTE dwvalue);

1

1

1 void F75111_SetWDTEnable (BYTE byteTimer);
: void F75111_SetWDTDisable ();

0x08

0x04

0x00
0x01
0x02
0x03

OnBoard F75111 Chipset
External F75111 Chipset

Configure GP1013 to WDT2 Function

Select Output Mode or Input Mode
Select GPI02X Output Mode or Input Mode
Select GPIO3X Output Mode or Input Mode

GPIO1X Input
GPIO3X Input

GPI102X Output
Select GPIO2X Output Mode or Input Mode
0-255 (secord or minute program by WDT_UNIT)

Configure WDT Function
When watchdog timeout.this bit will be set to 1.
" Enable watchdog timer
" Configure WDT output mode
/I 0:Level Mode
/I 1:Pulse Mode
" Watchdog unit select.
/I 0:Select second.
/I 1:Select minute.
I When select level output mode:
/I O:Level low
/I 1:Level high
I When select Pulse mode: 1 ms.
I When select Pulse mode: 20 ms.
I When select Pulse mode: 100 ms.

1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
n When select Pulse mode: 4 s. :
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
a
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3-15 I°C Bus Interface

® CO1: I’C (SM) bus connector (1 x 4 pin 1.25mm wafer)
PIN NO. 1 2

3 4
Description | +3.3V | GND | SMB_CLK | SMB_DATA

Note: 1. Mating connector: MOLEX 53047-0410 or compatible
2. Cable housing: MOLEX 51021-0400 or compatible

3-16 PS2 KB/MS

® CKM1: KB/MS port (1 X 6 pin 1.25mm wafer)
PIN NO. 1 2

3 4 5 6
Description +5V KB/DAT KB/CLK GND MS/DAT MS/CLK

Note: 1. Mating connector: MOLEX 53047-0610 or compatible
2. Cable housing: MOLEX 51021-0600 or compatible




3-15 LAN+USB Interface
® CL1: LAN Giga/100Mb (2 x 4pin 2.00mm wafer)

PIN NO. | Description PIN NO. | Description
1 TRO-/TX- 2 TRO+/TX+
3 TR2+/NC 4 TR1+/RX+
5 TR1-/RX- 6 TR2-/NC
7 TR3-/NC 8 TR3+/NC
CL1
I ;| pin1

eCL11: LAN LED (1 x

4pin 1.25mm wafer)

PIN NO.

1

2

3

4

DESCRIPTION

Vcec

Active LED

100Mb LAN

GIGA LAN




® CL4&5: LAN Giga/100Mb (RJ45 Jack)
CL48&5:LAN4 (down side)/LANS (up side) port connector

PIN NO. | Description PIN NO. | Description
1 TDO-/TX+ 2 TD2-/INC
3 TDO+/TX- 4 TD2+/RX-
5 TD1-/RX+ 6 TD3-/INC
7 TD1+/NC 8 TD3+/NC

® RJ45 LAN Connector---LED define Giga/100MB Connector

Speed 10 Mbps 100 Mbps 1000 Mbps
Indicate Back Side Front Sid Back Side Front Side Back Side Front Side
Link LED |[ACT LED|ACT LED|Link LED|ACT LED| ACT LED |Link LED |ACT LED | ACT LED
LAN Light X Orange | Orange | Green | Orange | Orange Red Orange | Orange
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¢ CUL2/CUL3 LAN + USB Connector
CUL2/CUL3 (Down side): USB3.0/2.0 Type A jack

PIN NO. | Description PIN NO. | Description
1 USB3.0 TX+
+5V
2 USB 2.0 D- 2 USB3.0 TX-
GND
USB 2.0 D+ 4 USB3.0 RX+
GND
5 USB3.0 RX-

Note: 1. USB 3.0 and USB 2.0 combo Type A Jack

* CUL2/CULS3 (Up side): LAN Giga/100Mb RJ45 Jack

PIN NO. | Description PIN NO. | Description
1 TDO-/TX+ 2 TD2-/INC
3 TDO+/TX- 4 TD2+/RX-
5 TD1-/RX+ 6 TD3-/NC
7 TD1+/NC 8 TD3+/NC

® RJ45 LAN Connector---LED define Giga/100/10MB Connector

Back side con RED LED GREEN LED YELLOW LED
Indicate GIGA LAN 100Mb LAN Active LED
Link(light) Link(light) Link(Blink)
CcuL3 CuL2
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e CU1/CU2/CU3/CU4/CU5: USB2.0 ports

PIN NO. | Description
1 +5V
2 USB DATA -
3 USB DATA +
4 GND

Note: 1. Attention! Check Device Power in spec
2. Mating connector: MOLEX 53047-0410 or compatible
3. Cable housing: MOLEX 51021-0400 or compatible

pin1

Ccu1
cu2
Ccu3
Cu4
CU5
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3-16 SATA interface
® SATA1/SATA2/SATA3/SATA4: SATA connectors
PIN NO. | Description
GND
DATATX+
DATATX-
GND
DATA RX-
DATA RX+
7 GND

oO|la|l~r|lwWwIN]—~

Note: 1. Support SATA 3.0 spec update 6Gb/sec .
2. CPO1, CPO2 provide SATA HDD power +12V, GND, +5V

pin1
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3-17 Module socket

® Mini card & SIM card & M.2 card
® MPCE1/MPCE2: Support USB and PCle or SATA by one Interface
(Mini card socket 52pin)

PIN NO. Description PIN NO. Description _l
1 NC 2 +3.3V *
3 NC 4 GND
5 NC 6 +1.5V
7 NC 8 SIM Power
9 GND 10 SIM Data
11 PCle-CLK- 12 SIM CLK
13 PCle-CLK+ 14 SIM Reset
15 GND 16 SIM RFU
KEY KEY KEY KEY
17 NC 18 GND
19 NC 20 NC
21 GND 22 RST-
23 PCle-RX-/mSATA-RX+ 24 +3.3V
25 PCle-RX+/mSATA-RX- 26 GND
27 GND 28 +1.5V
29 GND 30 SMB-CLK g ~
31 PCle-TX-/mSATA-TX- 32 SMB-DATA s §
33 PCle-TX+/mSATA-TX+ 34 GND £ =
35 GND 36 USB-DATA- £
37 GND 38 USB-DATA+ o
39 +3.3V 40 GND a . -
41 +3.3V 42 NC § §
43 GND 44 NC H =
45 NC 46 NC T
47 NC 48 +15V s
49 NC 50 GND
51 MSATA-Detect 52 +3.3V

Note: 1. MPCE1/MPCE2 Full size
2. MPCE1/MPCE2 Pin 8, 10,12,14,16 for SIM1 card reader use
3. MPCE1 Pin23, 25, 31, 33 supported mSATA device and PCle device alternatively
4. MPCE1 Pin51 mSATA/PCle auto detect function
5. MPCE2 Pin 23, 25, 31, 33 for PCle Only
6. MPCE2 Pin51 for NC
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3-18 SIM socket
o SIM1/SIM2: SIM card socket pin define is follow ISO 7816-2 smart card standard.

PIN NO. |DESCRIPTION PIN NO. |DESCRIPTION
1 Vce 5 GND
2 RST 6 Vpp
3 CLK 7 DATA
4 RUF 8 RUF

Note: 1. MPCE1 Pin 8, 10,12,14,16 for SIM1 card reader use.
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® NGFF1: Support M.2 B key Type 22110 SATA Interface

PIN DESCRIPTION PIN | DESCRIPTION
NO. Top Side NO. Bottom Side

75 GND

73 GND 74 +3.3V

71 GND 72 +3.3V

69 SATA-Detect 70 +3.3V

67 NC 68 NC

65 NC 66 NC

63 NC 64 NC

61 NC 62 NC

59 NC 60 NC

57 GND 58 NC

55 PCle-CLK+ 56 NC

53 PCle-CLK- 54 NC

51 GND 52 NC

49 |PCle0-TX+/SATA-TX+| 50 PCle-RST-

47 | PCle0-TX-/SATA-TX- | 48 NC

45 GND 46 NC

43 |PCle0-RX+/SATA-RX-| 44 NC

41 |PCIe0-RX-/SATA-RX+| 42 NC NGFF1
39 GND 40 NC E
37 PCle1-TX+ 38 +3.3V

35 PCle1-TX- 36 NC

33 GND 34 NC

31 PCle1-RX+ 32 NC

29 PCle1-RX- 30 NC

27 GND 28 NC CO—
25 NC 26 NC

23 NC 24 NC

21 GND 22 NC

20 NC
Mechanical Key

PIN DESCRIPTION PIN | DESCRIPTION
NO. Top Side NO. Bottom Side

11 NC

9 NC 10 NC

7 NC 8 NC

5 NC 6 NC

3 GND 4 +3.3V

1 GND 2 +3.3V

Note: 1. Support SATA/ PCle Based SSD Module
2. No Support PCle / USB 3.0 / SSIC Based WWAN Module
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3-19 SODIMM socket

SODIMM1 SODIMM2

Note: 1.SODIM1/ SODIM2: SO-DIMM DDR4 1.2V DRAM Socket
2. Support un-buffer type module
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e
3-20 PCle X16 Gold Finger PIN Define

PIN NO. PIN NO.
A1 [NC B1 |+12v
A2 |+12v B2 |[+12v
A3 |+12v B3 |+12v
A4 |GND B4 |GND
A5 [+3.3V B5 |SMB_CLK
A6 |+3.3V B6 |SMB_DATA
A7 |+3.3V B7 |GND
A8 [+3.3V B8  [+3.3V
A9 [+3.3V B9 [+3.3V
A10 [+3.3V B10 |+3.3VAUX

A1 PCIEX16_PLT_RST# B11 PCIE_WAKE#

Mechanical Key

A12  |GND B12 NC

A13 |CLK_PCIEX16_P B13 GND

A14 |CLK_PCIEX16_N B14 PEG_TXPO
A15 | GND B15 PEG_TXNO
A16 | PEG_RXPO B16 GND

A17 | PEG_RXNO B17 PCIEX16_CLKREQ#
A18 |GND B18 GND

A19 |NC B19 PEG_TXP1
A20 |GND B20 PEG_TXN1
A21 PEG_RXP1 B21 GND

A22 PEG_RXN1 B22 GND

A23 |GND B23 PEG_TXP2
A24 |GND B24 PEG_TXN2
A25 | PEG_RXP2 B25 GND

A26 |PEG_RXN2 B26 GND

A27 |GND B27 PEG_TXP3
A28 |GND B28 PEG_TXN3
A29 |PEG_RXP3 B29 GND

A30 PEG_RXN3 B30 NC

A31 GND B31 PCIEX16_CLKREQ#
A32 NC B32 GND
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PIN NO. PIN NO.
A33 |NC B33 PEG_TXP4
A34 |GND B34 PEG_TXN4
A35 | PEG_RXP4 B35 GND
A36 PEG_RXN4 B36 GND
A37 |GND B37 PEG_TXP5
A38 |GND B38 PEG_TXN5
A39 | PEG_RXP5 B39 GND
A40 PEG_RXN5 B40 GND
A41 GND B41 PEG_TXP6
A42 |GND B42 PEG_TXN6
A43 | PEG_RXP6 B43 GND
Ad4 PEG_RXNG6 B44 GND
A45 |GND B45 PEG_TXP7
A46 |GND B46 PEG_TXN7
A47 | PEG_RXP7 B47 GND
A48 | PEG_RXN7 B48 PCIEX16_CLKREQ#
A49 |GND B49 GND
A50 NC B50 PEG_TXP8
A51 GND B51 PEG_TXN8
A52 PEG_RXP8 B52 GND
A53 | PEG_RXNS8 B53 GND
A54 | GND B54 PEG_TXP9
A55 |GND B55 PEG_TXN9
A56 PEG_RXP9 B56 GND
A57 | PEG_RXN9 B57 GND
A58 |GND B58 PEG_TXP10
A59 |GND B59 PEG_TXN10
A0 PEG_RXP10 B60 GND
AG1 PEG_RXN10 B61 GND
A62 |GND B62 PEG_TXP11
A63 |GND B63 PEG_TXN11
A4 PEG_RXP11 B64 GND
A65 |PEG_RXNM B65 GND
A66 |GND B66 PEG_TXP12
A67 |GND B67 PEG_TXN12

___________________________________________________________________________|
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PIN NO. PIN NO.
A68 PEG_RXP12 B68 GND
AB9 PEG_RXN12 B69 GND
A70 |GND B70 PEG_TXP13
AT1 GND B71 PEG_TXN13
AT2 PEG_RXP13 B72 GND
A73 PEG_RXN13 B73 GND
A74 |GND B74 PEG_TXP14
A75 |GND B75 PEG_TXN14
A76 PEG_RXP14 B76 GND
AT7 PEG_RXN14 B77 GND
A78 |GND B78 PEG_TXP15
A79 |GND B79 PEG_TXN15
A80 PEG_RXP15 B80 GND
A81 PEG_RXN15 B81 PCIEX16_CLKREQ#
A82 |GND B82 NC
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Chapter-4

Introduction of BIOS

The BIOS is a program located in the Flash Memory on the motherboard. This program is
a bridge between motherboard and operating system. When you start the computer, the
BIOS program gains control. The BIOS first operates an auto-diagnostic test called POST
(Power on Self Test) for all the necessary hardware, it detects the entire hardware devices
and configures the parameters of the hardware synchronization. After these tasks are
completed, BIOS will give control of the computer back to operating system (OS). Since
the BIOS is the only channel for hardware and software to communicate with, it is the key
factor of system stability and of ensuring your system performance at best.

4-1 Enter Setup

Power on the computer and press <Del> key immediately to enter Setup.

If the message disappears before your respond but you still wish to enter Setup, restart
the system by turning it OFF then ON. You may also restart the system by simultaneously
pressing <Ctrl>, <Alt> and <Delete> keys. If you do not press the keys at the proper time
and the system does not boot, an error message will display and you will be asked to
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4-2 BIOS Menu Screen

The following diagram show a general BIOS menu screen

— Menu Bar

Main Advanced ChiEset Boot Securitx Save & Exit

BIOS Information Display platform information
BIOS Vendor American Megatrends

Core Version 5.12 |

Compliancy UEFI2.5; Pl1.4 v

BIOS Version CI170A/C AL General Help Items
Build Date and Time 08/18/2017 11 : 15: 14

Access Level Administrator

BIOS Name 170-031

» Platform Information

System Date [Tue 08/30/2017]
System Time [10:28:51]
—<—: Select Screen
1 | : Select Item
Enter: Select
l l +/-: Change Opt.
M . F1: General Help
enu Items Current Setting Value )
F2: Previous Values
F3: Optimized Defaults
Function Keys ¥ Fa: S::ve&Exit
Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

4-3 Function Keys

In the above BIOS Setup main menu of, you can see several options. We will explain these options step by
step in the following pages of this chapter, but let us first see a short description of the function keys you
may use here:

* Press —— (left, right) to select screen;

* Press 1] (up, down) to choose, in the main menu, the option you want to confirm or to modify.

* Press <Enter> to select.

* Press <+>/<—> keys when you want to modify the BIOS parameters for the active option.

* [F1]: General help.

« [F2]: Previous value.

« [F3]: Optimized defaults.

« [F4]: Save & exit.

* Press <Esc> to quit the BIOS Setup.

___________________________________________________________________________|
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4-4 Getting Help

Main Menu

The on-line description of the highlighted setup function is displayed at the top right corner

the screen.

Status Page Setup Menu/Option Page Setup Menu
Press F1 to pop up a small help window that describes the appropriate keys to use and
the possible selections for the highlighted item. To exit the Help Window, press <Esc>.

4-5 Menu Bars

There are six menu bars on top of BIOS screen:

Main To change system basic configuration
Advanced To change system advanced configuration
Chipset To change chipset configuration

Boot To change boot settings

Security Password settings

Save & Exit  Save setting, loading and exit options.

User can press the right or left arrow key on the keyboard to switch from menu bar.

The selected one is highlighted.

4-6 Main

Main Advanced Chipset

Security Save & Exit

BIOS Information
BIOS Vendor

Core Version
Compliancy

BIOS Version

Build Date and Time
Access Level

BIOS Name

» Platform Information

System Date
System Time

American Megatrends
5.12

UEFI25; PI1.4
CI170A/C Al
08/18/2017 11 : 15 : 14
Administrator

170-031

[Tue 08/30/2017]
[10:28:51]

Display platform information

—<— Select Screen

1 | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.
|
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Main menu screen includes some basic system information. Highlight the item and then use
the <+> or <-> and numerical keyboard keys to select the value you want in each item.
Platform Information

Display platform information

System Date

Set the Date. Please use [Tab] to switch between data elements.

System Time

Set the Time. Please use [Tab] to switch between data elements.

4-7 Advanced
Main Advanced Chipset Boot Security Save & Exit
» CPU Configuration CPU Configuration
» Trusted Computing Parameters

» ACPI Settings

»F81966 Super |0 Configuration

» Hardware Monitor

»F81216SEC Super |0 Configuration
» Serial Port Console Redirection

»Intel TXT Information — < Select Screen
» Network Stack Configuration 1 | : Select Item
» CMS Configuration Enter: Select

» USB Configuration +/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

CPU Configuration

Please refer section 1-7-1

Trusted Computing

Please refer section 1-7-2

ACPI Settings

Please refer section 1-7-3

F81966 Super 10 Configuration

Please refer section 1-7-4

Hardware Monitor

Please refer section 1-7-5

F81216SEC Super IO Configuration

Please refer section 1-7-6

|
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Serial Port Console Redirection
Please refer section 1-7-7

Intel TXT Information
Please refer section 1-7-8

Network Stack Configuration
Please refer section 1-7-9

CMS Configuration
Please refer section 1-7-10

USB Configuration
Please refer section 1-7-11

4-7-1 CPU Configuration

Press [Enter] to view CPU Configuration.

4-7-2 Trusted Computing

Main Advanced Chipset Boot Security Save & Exit

Configuration Enables or Disables BIOS
Security Device Support [Disabled] support for security Device.
NO Security Device Found 0.S. Will not show Security

Device. TCG EFI protocol and
INT1A interface will not be
available.

—<—: Select Screen

1 | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Security Device Support
Use this item to enable or disable Security Device.
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4-7-3 ACPI Settings

Main Advanced Chipset Boot Security Save & Exit

ACPI Settings Enables or Disables System
ability to Hibernate (DS/S4

Enable Hibernation [Enabled] Sleep State). This option

ACPI Sleep State [S3 (Suspend to RAM)] | may not be effective with
some operating systems.

USB Power state in S3-S5 [Enabled]

Power Failure [Keep last state] — < Select Screen

Critical Trip Paint [103 C] + | : Select Item

Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Enable Hibernation

This item allows you to Enabled / Disabled the Hibernate feature.

ACPI Sleep State

Select ACPI sleep state the system will enter when the SUSPEND button is pressed.

The optional settings: Suspend Disabled / S3 (Suspend to RAM).

USB Power state in S3-S5

Enabled / Disabled USB Power delivery in S3 (Sleep). S4 (Hibernate) and S5 (Soft off) States.
Power Failure

This item specifies whether your system will reboot after a power failure or interrupt occurs.

[Keep last state] Restores the system to the status before power failure or interrupt occurred.

[Always on] Leaves the computer in the power on state.

[Always off] Leaves the computer in the power off state.

Critical Trip Point

This value controls the temperature of the ACPI Critical Trip Point — the point in which the OS will shut
the system off.

The optional settings: Disabled / 119 C /111 C/103C/100C/95C/87C/79C/71C/63C/55C
/47C/39C/31C/23C/15C.
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4-7-4 F81966 Super 10 Configuration

Main Advanced Chipset Boot Security Save & Exit

F81966 Super 10 Configuration Set Parameters of Serial
Port 1(COMA)
Super IO Chip F81966
» Serial Port 1 Configuration
» Serial Port 2 Configuration — < Select Screen
» Serial Port 3 Configuration 1 | : Select ltem
» Serial Port 4 Configuration Enter: Select
» Serial Port 5 Configuration +/-: Change Opt.
» Serial Port 6 Configuration F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Serial Port 1 Configuration
Please refer section 1-7-4-1
Serial Port 2 Configuration
Please refer section 1-7-4-2
Serial Port 3 Configuration
Please refer section 1-7-4-1
Serial Port 4 Configuration
Please refer section 1-7-4-1
Serial Port 5 Configuration
Please refer section 1-7-4-1
Serial Port 6 Configuration
Please refer section 1-7-4-1
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4-7-4-1 » Serial Port 1 Configuration

Main Advanced Chipset Boot Security Save & Exit

Serial Port 1 Configuration Enable or Disable Serial
Port (COM)
Serial Port [Enabled]
Device Settings 10=3F8h; IRQ=4;
—<—: Select Screen
Change Settings [AUTO] t | : Select Item
Uart Mode [RS232] Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Serial Port

Use this item to enable or disable serial port (COM).

The optional settings are: Enabled, Disabled.

Device Settings

Serial Port 1 10=3F8h; IRQ=4;

Change Settings

Use this item to select an optimal setting for super |10 device.
The optional settings are:

AUTO

10=3F8h; IRQ=4;

10=3F8h; IRQ=3, 4, 5, 6, 7, 9,10,11,12;

10=2F8h; IRQ=3, 4, 5, 6, 7, 9,10,11,12;

10=3E8h; IRQ=3, 4, 5, 6, 7, 9,10,11,12;

10=2E8h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

Uart Mode

Use this item to select COM Port as RS232, RS422 or RS485 mode.
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4-7-4-2 » Serial Port 2 Configuration

Main Advanced Chipset

Boot

Security Save & Exit

Serial Port 2 Configuration

Enable or Disable Serial
Port (COM)

Serial Port [Enabled]

Device Settings I0=2F8h; IRQ=3;
—<—: Select Screen

Change Settings [AUTO] 1 | : Select Item

Uart Mode [RS232] Enter: Select
+/-: Change Opt.
F1: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.
Serial Port

Use this item to enable or disable serial port (COM).

The optional settings are: Enabled, Disabled.

Device Settings
Serial Port 2 10=2F8h; IRQ=3;
Change Settings

Use this item to select an optimal setting for super |10 device.

The optional settings are:
AUTO
10=2F8h; IRQ=3 ;

10=3F8h; IRQ=3, 4, 5, 6,7, 9,10,11,12;
10=2F8h; IRQ=3, 4, 5, 6, 7, 9,10,11,12;
10=3E8h; IRQ=3, 4, 5,6, 7,9,10,11,12;
10=2E8h; IRQ=3, 4, 5, 6, 7,9,10,11,12 ;

Uart Mode

Use this item to select COM Port as RS232, RS422 or RS485 mode.
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4-7-4-3 » Serial Port 3 Configuration

Main Advanced Chipset

Boot

Security Save & Exit

Serial Port 3 Configuration

Serial Port
Device Settings

Change Settings
Uart Mode

[Enabled]
10=3E8h; IRQ=7;

[AUTO]
[RS232]

Enable or Disable Serial
Port (COM)

—<—: Select Screen

t | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Serial Port

Use this item to enable or disable serial port (COM).

The optional settings are: Enabled, Disabled.

Device Settings
Serial Port 3 10=3E8h; IRQ=7;
Change Settings

Use this item to select an optimal setting for super 10 device.

The optional settings are:
AUTO
10=3E8h; IRQ=7 ;

10=3F8h; IRQ=3, 4, 5, 6, 7,9,10,11,12;
10=2F8h; IRQ=3, 4, 5, 6, 7,9,10,11,12;
10=3E8h; IRQ=3, 4, 5, 6, 7, 9,10,11,12;
10=2E8h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

Uart Mode

Use this item to select COM Port as RS232, RS422 or RS485 mode.
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4-7-4-4 » Serial Port 4 Configuration

Main Advanced Chipset Boot Security Save & Exit

Serial Port 4 Configuration Enable or Disable Serial
Port (COM)
Serial Port [Enabled]
Device Settings I0=2E8h; IRQ=7;
— < Select Screen
Change Settings [AUTO] 1| : Select Item
Uart Mode [RS232] Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Serial Port

Use this item to enable or disable serial port (COM).

The optional settings are: Enabled, Disabled.

Device Settings

Serial Port 4 10=2E8h; IRQ=7;

Change Settings

Use this item to select an optimal setting for super 10 device.
The optional settings are:

AUTO

10=2E8h; IRQ=7 ;

10=3F8h; IRQ=3, 4, 5, 6, 7, 9,10,11,12;

10=2F8h; IRQ=3, 4, 5, 6,7, 9,10,11,12;

10=3E8h; IRQ=3, 4, 5, 6, 7, 9,10,11,12;

10=2E8h; IRQ=3, 4, 5, 6,7, 9,10,11,12 ;

Uart Mode

Use this item to select COM Port as RS232, RS422 or RS485 mode.
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4-7-4-5 » Serial Port 5 Configuration

Main Advanced Chipset Boot Security Save & Exit

Serial Port 5 Configuration Enable or Disable Serial
Port (COM)
Serial Port [Enabled]
Device Settings 10=2F0h; IRQ=7;
—<—: Select Screen
Change Settings [AUTQ] t | : Select Item
Uart Mode [RS232] Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Serial Port

Use this item to enable or disable serial port (COM).

The optional settings are: Enabled, Disabled.

Device Settings

Serial Port 5 10=2F0h; IRQ=7;

Change Settings

Use this item to select an optimal setting for super |10 device.
The optional settings are:

AUTO

10=2F0h; IRQ=7 ;

10=3E8h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

10=2E8h; IRQ=3, 4, 5, 6, 7, 9,10,11,12;

10=2F0h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

10=2E0h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

Uart Mode

Use this item to select COM Port as RS232, RS422 or RS485 mode.
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4-7-4-6 » Serial Port 6 Configuration

Main Advanced Chipset Boot Security Save & Exit

Serial Port 6 Configuration Enable or Disable Serial
Port (COM)
Serial Port [Enabled]
Device Settings 10=2E0h; IRQ=7;
—<—: Select Screen
Change Settings [AUTO] 1 | : Select Item
Uart Mode [RS232] Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Serial Port

Use this item to enable or disable serial port (COM).

The optional settings are: Enabled, Disabled.

Device Settings

Serial Port 6 10=2E0h; IRQ=7;

Change Settings

Use this item to select an optimal setting for super 10 device.
The optional settings are:

AUTO

10=2EO0h; IRQ=7 ;

10=3E8h; IRQ=3, 4, 5, 6, 7, 9,10,11,12;

10=2E8h; IRQ=3, 4, 5, 6, 7, 9,10,11,12;

10=2F0h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

10=2E0h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

Uart Mode

Use this item to select COM Port as RS232, RS422 or RS485 mode.

4-7-5 Hardware Monitor

Press [Enter] to view PC health status.
This section shows the status of your CPU, Fan, and overall system. This is only available when there
is Hardware Monitor function onboard.
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4-7-6 F81216SEC Super 10 Configuration

Main Advanced Chipset Boot Security Save & Exit

F81216SEC Super 10 Configuration Set Parameters of Serial
Port 1(COMA)

Super 10 Chip F81216SEC
» Serial Port 1 Configuration
» Serial Port 2 Configuration — < Select Screen
» Serial Port 3 Configuration 1 | : Select Item
» Serial Port 4 Configuration Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.
Serial Port 1 Configuration
Please refer section 1-7-6-1
Serial Port 2 Configuration
Please refer section 1-7-6-2
Serial Port 3 Configuration
Please refer section 1-7-6-1

Serial Port 4 Configuration
Please refer section 1-7-6-1

4-7-6-1 » Serial Port 1 Configuration

Main Advanced Chipset Boot Security Save & Exit

Serial Port 1 Configuration Enable or Disable Serial
Port (COM)
Serial Port [Enabled]
Device Settings 10=240h; IRQ=5;
—<—: Select Screen
Change Settings [AUTO] t | i Select Item
Uart Mode [RS232] Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.
|
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Serial Port

Use this item to enable or disable serial port (COM).

The optional settings are: Enabled, Disabled.

Device Settings

Serial Port 1 10=240h; IRQ=5;

Change Settings

Use this item to select an optimal setting for super 10 device.
The optional settings are:

AUTO

10=240h; IRQ=5;

10=240h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

10=248h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

10=250h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

10=258h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

Uart Mode

Use this item to select COM Port as RS232, RS422 or RS485 mode.

4-7-6-2 » Serial Port 2= Configuration

Main Advanced Chipset Boot Security Save & Exit

Serial Port 2 Configuration Enable or Disable Serial
Port (COM)
Serial Port [Enabled]
Device Settings 10=248h; IRQ=5;
—<—: Select Screen
Change Settings [AUTO] t | i Select Item
Uart Mode [RS232] Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Serial Port

Use this item to enable or disable serial port (COM).

The optional settings are: Enabled, Disabled.

Device Settings

Serial Port 2 10=248h; IRQ=5;

|
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Change Settings

Use this item to select an optimal setting for super IO device.
The optional settings are:

AUTO

10=248h; IRQ=5;

10=240h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

10=248h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

10=250h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

10=258h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

Uart Mode

Use this item to select COM Port as RS232, RS422 or RS485 mode.

4-7-6-3 » Serial Port 3 Configuration

Main Advanced Chipset Boot Security Save & Exit

Serial Port 3 Configuration Enable or Disable Serial
Port (COM)
Serial Port [Enabled]
Device Settings 10=250h; IRQ=5;
—<—: Select Screen
Change Settings [AUTO] t | : Select Item
Uart Mode [RS232] Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Serial Port

Use this item to enable or disable serial port (COM).

The optional settings are: Enabled, Disabled.

Device Settings

Serial Port 3 10=250h; IRQ=5;

Change Settings

Use this item to select an optimal setting for super 10 device.

The optional settings are:

AUTO

10=250h; IRQ=5;

|
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10=240h; IRQ=3, 4, 5, 6, 7, 9,10,11,12;

10=248h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

10=250h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

10=258h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

Uart Mode

Use this item to select COM Port as RS232, RS422 or RS485 mode.

4-7-6-4 » Serial Port 4 Configuration

Main Advanced Chipset Boot Security Save & Exit

Serial Port 4 Configuration Enable or Disable Serial
Port (COM)
Serial Port [Enabled]
Device Settings 10=258h; IRQ=5;
—<—: Select Screen
Change Settings [AUTO] 1 | : Select Item
Uart Mode [RS232] Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Serial Port

Use this item to enable or disable serial port (COM).

The optional settings are: Enabled, Disabled.

Device Settings

Serial Port 4 10=258h; IRQ=5;

Change Settings

Use this item to select an optimal setting for super 10 device.

The optional settings are:

AUTO

10=258h; IRQ=5;

10=240h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

10=248h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

10=250h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

10=258h; IRQ=3, 4, 5, 6, 7, 9,10,11,12 ;

Uart Mode

Use this item to select COM Port as RS232, RS422 or RS485 mode.

|
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4-7-7 Serial Port Console Redirection
Main Advanced Chipset Boot Security Save & Exit

Console Redirection Enable
COMO or Disable.
Console Redirection [Disabled]
» Console Redirection Settings

—<—: Select Screen

Legacy Console Redirection * | : Select Item
» Legacy Console Redirection Settings Enter: Select
+/-: Change Opt.
F1: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Console Redirection
Use this item to enable or disable Console Redirection.
The optional settings are: Enabled, Disabled.

4-7-8 Intel TXT Information

Press [Enter] to view Intel TXT Information.

4-7-9 Network Stack Configuration
Main Advanced Chipset Boot Security Save & Exit

Network stack [Disabled] Enable/Disable UEFI
network stack.

—<—: Select Screen

t | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Network Stack

Enable/Disable UEFI network stack.

The optional settings are: Disabled, Enabled.

|
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4-7-10 CSM Configuration

Main Advanced Chipset Boot Security Save & Exit

Compatibility Support Module Configuration Enable/Disable CSM
Support.
CSM Support [Disabled]

—<—: Select Screen
1| : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

CSM Support
Enable/Disable CSM Configuration.
The optional settings are: Disabled, Enabled.

4-7-11 USB Configuration

Main Advanced Chipset Boot Security Save & Exit

USB Configuration Enables Legacy USB
support AUTO option
USB Module Version 17 disables legacy support if no
USB devices are connected.
USB Controllers : Disable option will keep
1 XHCI USB devices available only
USB Devices : for EFI applications.
1 Mouse —<—: Select Screen
+ | : Select Item
Legacy USB Support [Enabled] Enter: Select
XHCI Hand-off [Enabled] +/-: Change Opt.
USB Mass Storage Driver Support [Enabled] F1: General Help
Port 60/64 Emulation [Disabled] F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
Esc: Exit

Version 2.14.1219. Copyright (C) 2011 American Megatrends, Inc.
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Legacy USB Support

Enables Legacy USB support. AUTO option disables legacy support if no USB devices are

connected. Disable option will keep USB devices available only for EFI applications.

The optional settings are: Enabled, Disabled.

XHCI Hand-off

This is a workaround for OSes without XHCI handoff support. The XHCI ownership change should be
claimed by XHCI driver.

The optional settings are: Enabled, Disabled.

USB Mass Storage Driver Support

Enabled/Disabled USB Mass Storage Driver Support.

The optional settings are: Enabled, Disabled.

Port 60/64 Emulation

Enabled 1/O port 60h/64h emulation support. This should be enabled for the complete USB Keyboard
legacy support for non-USB aware OSes.

The optional settings are: Enabled, Disabled.

4-8 Chipset
Main Advanced Chipset Boot Security Save & Exit
» System Agent (SA) Configuration PCH Parameters

» PCH-IO Configuration

—<—: Select Screen

+ | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

System Agent (SA) Configuration
Please refer section 1-8-1

PCH-IO Configuration
Please refer section 1-8-2
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4-8-1 System Agent (SA) Configuration

Main Advanced Chipset Boot Security Save & Exit

System Agent (SA) Configuration Memory Configuration
Parameters
SA PCle Code Version 1.4.1.0
VT-d Supported
—<—: Select Screen
» Memory Configuration + | : Select Item
» Graphics Configuration Enter: Select
»PEG Port Configuration +/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Memory Configuration
Please refer section 1-8-1-1

Graphics Configuration
Please refer section 1-8-1-2

PEG Port Configuration
Please refer section 1-8-1-3

4-8-1-1 Memory Configuration

Press [Enter] to view Memory Information.
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4-8-1-2 Graphics Configuration

Main Advanced Chipset Boot Security Save & Exit

Graphics Configuration Select which of

IGFX/PEG/PCI Graphics
Primary Display [Auto] device should be Primary
Internal Graphics [Auto] Display Or select SG for
Active LFP [No eDP] Switchable Gfx.

—<—: Select Screen

1 | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit
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Primary Display

Select which of IGFX/PEG Graphics device should be Primary Display Or select SG for Switchable Gfx.
The optional settings are: Auto, IGFX, PEG.

Internal Graphics

Keep IGFX enabled based on the setup options.

The optional settings are: Auto, Enabled, Disabled.

Active LFP

Select the Active LFP Configuration.

No eDP: VBIOS does not enabled LFP.

eDP Port-A: LFP Driven by Int-DisplayPort encoder from Port-A.
The optional settings are: No eDP, eDP Port-A.
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4-8-1-3 PEG Port Configuration

Main Advanced Chipset Boot Security Save & Exit

PEG Port Configuration PEG Lane Configuration
PEG Lane [1x16]
PEG 0:1:0 Not Present
Enable Root Port [Auto]
Max Link Speed [Auto]
PEG 0:1:1 Not Present
Enable Root Port [Auto]
Max Link Speed [Auto]
PEG 0:1:2 Not Present
Enable Root Port [Auto]
Max Link Speed [Auto]

—<—: Select Screen

+ | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit
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PEG Lane

PEG Lane Configuration

1x16: Support One x16 PCle.

2x8: Support Two x8 PCle.

1x8, 2x4: Support One x8 and Two x4 PCle.
The optional settings are: 1x16, 2x8, 1x8,2x4.

PEG 0: 1:0/ PEG 0:1:1 / PEG 0:1:2

view PEG Lane Port Information.

Enable Root Port

Enabled or Disabled the Root Port.

The optional settings are: Auto, Enabled, Disabled.
Max Link Speed

Configure PEG Port Max Speed.

The optional settings are: Auto, Gen1, Gen2, Gne3.

___________________________________________________________________________|
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4-8-2 PCH-IO Configuration

Main Advanced Chipset Boot Security Save & Exit

PCH-10 Configuration PCI Express Configuration
settings

» PCI Express Configuration
»SATA And RST Configuration

—<—: Select Screen
1| : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

PCI Express Configuration
Please refer section 1-8-2-1

SATA And RST Configuration
Please refer section 1-8-2-2
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4-8-2-1 PCI Express Configuration

Main Advanced Chipset Boot Security Save & Exit

PCI Express Configuration PCI Express Configuration
settings
PCIE Port assigned to LAN 4

» PCI Express Root Port 5 (1210/1211 LAN2)
» PCI Express Root Port 6 (1210/1211 LAN3)
» PCI Express Root Port 7 (1210/1211 LAN4)
» PCI Express Root Port 8 (1210/1211 LAN5)
» PCI Express Root Port 10 (Mini PClel)

» PCI Express Root Port 11 (Mini PCle2)

» PCI Express Root Port 19 (M.2 PCle x2)

—<—: Select Screen

+ | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

PCI Express Root Port 5/6/7/8 (1210/1211 LAN2/3/4/5)
Please refer section 1-8-2-1-1

PCI Express Root Port 10/11 (Mini PCle1/2)
Please refer section 1-8-2-1-1

PCI Express Root Port 19 (M.2 PCle x2)
Please refer section 1-8-2-1-1
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4-8-2-1-1 PCI Express Root Port 5/6/7/8 (1210/1211 LAN2/3/4/5)

Main Advanced Chipset Boot Security Save & Exit

PCI Express Root Port 5/6/7/8 [Enabled] Control the PCI Express
ASPM [Disabled] Root Port.

PCle Speed [Auto]

Detect Timeout 0

—<—: Select Screen

t | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

PCI Express Root Port 5/6/7/8

Control the PCI Express Root Port.

The optional settings are: Enabled, Disabled.

ASPM

Select the ASPM Level.

The optional settings are: Auto, LOsL1, L1, LOs, Disabled.

PCle Speed

Select PCI Express port speed.

The optional settings are: Auto, Gen1, Gen2, Gen3.

Detect Timeout

The number of milliseconds reference code will wait for link to exit Detect state for enabled ports
before assuming there is no device and potentially disabling the port.
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4-8-2-2 SATA And RST Configuration

Main Advanced Chipset Boot Security Save & Exit

SATA And RST Configuration Enable / Disable SATA
Device.
SATA Controller(S) [Enabled]
SATA Mod Selection [AHCI]
SATA Controller Speed [Default]
SATA1 Empty
Port 0 [Enabled]
SATA Device Type [Hard Disk Drive]
SATA2 Empty
Port 1 [Enabled]
SATA Device Type [Hard Disk Drive]
SATA3 Empty
Port 2 [Enabled] — < Select Screen
SATA Device Type [Hard Disk Drive] + | : Select ltem
SATA4 Empty Enter: Select
Port 3 [Enabled] +/-: Change Opt.
SATA Device Type [Hard Disk Drive] F1: General Help
SATA5 (MSATA) Empty F2: Previous Values
Port 4 [Enabled] F3: Optimized Defaults
SATA Device Type [Hard Disk Drive] F4: Save & Exit
SATA6 (M.2) Empty Esc: Exit
Port 5 [Enabled]
SATA Device Type [Hard Disk Drive]

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

SATA Controller(S)

Enable / Disable SATA Device.

The optional settings are: Enabled, Disabled.

SATA Mod Selection

Determines how SATA controller(s) operate.

The optional settings are: AHCI, Intel RST Premium.

SATA Controller Speed

Indicates the maximum speed the SATA controller can support.

The optional settings are: Default, Gen1, Gen2, Gen3.

SATA1/ SATA2/ SATA3/ SATA4/ SATA5 (mSATA)/ SATAG6 (M.2)
View SATA Port Information.

Port 0/ Port 1/ Port 2/ Port 3/ Port 4/ Port 5

Enable / Disable SATA Port.

The optional settings are: Enabled, Disabled.

SATA Device Type

Identify the SATA port is connected to Solid State Drive or Hard Disk Drive.

The optional settings are: Hard Disk Drive, Solid State Drive.
|
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4-9 Security

Main Advanced Chipset Boot Security Save & Exit

Password Description Set Administrator Password

If ONLY the Administrator’s password is set,
then this only limits access to Setup and is

only asked for when entering Setup.

If ONLY the User’s password is set, then this

is a power on password and must be entered to
boot or enter Setup. In Setup the User will

have Administrator right. —><— Select Screen
The password length must be + | : Select ltem
in the following range: Enter: Select
Minimum length 3 +/-: Change Opt.
Maximum length 20 F1: General Help

F2: Previous Values

F3: Optimized Defaults
Administrator Password F4: Save & Exit

User Password Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Administrator Password & User Password

To set up an administrator password:

1. Select Administrator / User Password. The screen then pops up an Create New Password dialog.
2. Enter your desired password that is no less than 3 characters and no more than 20 characters.
3. Hit [Enter] key to submit.
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4-10 Boot
Main Advanced Chipset Boot Security Save & Exit
Boot Configuration Number of seconds to wait
Setup Prompt Timeout 1 for setup activation Key.
Bootup NumLock State [On] 65535(0XFFFF) means
Quiet Boot [Enabled] indefinite waiting.

Driver Option Prioritiies
New Boot Option Policy [Default]

—<—: Select Screen

+ | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Setup Prompt Timeout

Number of seconds to wait for setup activation Key. 65535(0xFFFF) means indefinite waiting.
Bootup NumLock State

Use this item to select keyboard NumLock State.

The optional settings are: On, Off.

Quiet Boot

The optional settings are: Enabled, Disabled.

New Boot Option Policy

Controls the placement of newly detected UEFI boot options.

The optional settings are: Default, Place First, Place Last.
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4-11 Save & Exit

Main Advanced Chipset Boot Security Save & Exit

Save Options Reset the system after
Save Changes and Reset saving the changes.
Discard Changes and Reset

Default Options
Restore Defaults

Boot Override
Launch EFI shell from filesystem device —><— Select Screen

+ | : Select Item
Enter: Select

+/-: Change Opt.

F1: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

Esc: Exit

Version 2.18.1263. Copyright (C) 2017 American Megatrends, Inc.

Save Changes and Reset

This item allows user to reset the system after saving the changes.

Discard Changes and Reset

This item allows user to reset the system setup without saving any changes.

Restore Defaults

Use this item to restore load default values for all the setup options.

Launch EFI shell from filesystem device

Attempts to launch EFI shell application (Shell.efi) from one of the available filesystem device.
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Chapter-5

DRIVER INSTALLATION

There is a system installation DVD in the package. This DVD does not only include all the
drivers you need but also some other free application programs and utility programs.

In addition, this DVD also includes an auto detect software telling you which hardware is
installed and which driver is needed so that your system can function properly. We call this
auto detect software SYSTEM INSTALL.

SYSTEM INSTALL Supports Windows 7 / Windows 10

Insert the DVD into your DVD-ROM drive and the SYSTEM INSTALL menu should appear as below.
If the menu does not appear, double-click MY COMPUTER and double-click DVD-ROM drive or click
START, click RUN, and type X:\autorun.EXE (assuming your DVD-ROM drive is X).

System install

Auto Detect Mainboard and OS

Make your selection from SYSTEM INSTALL menu:

1. Auto Detect Main board and OS to AUTOMATIC DRIVER INSTALLATION menu
2. Browse DVD to view the contents of the DVD
3. Exit to exit SYSTEM INSTALL menu
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AUTOMATIC DRIVER INSTALLATION menu

1. INF install Intel SkyLake chipset driver

2. VGA install onboard VGA driver

3. HD Audio install ALC HD Audio Codec driver

4. ME Tool install Intel Management Engine Interface driver
5. LAN install LAN driver

Each selection is illustrated below:

Sky Lake for Windows 10 (x64)
Compatible on Windows 8.1 x64
INF
ME Tool
VGA
LAN
HD Audio

Back to previous page
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5-1 INF

Sky Lake for Windows 10 (x64)

INF

ME Tool
VGA

LAN
HD Audio

Lo previous page

1. At the "AUTOMATIC DRIVER INSTALLATION

menu" screen, click "INF".

Install Intel SkyLake Chipset Driver

Device Software

Vou are abaut o insall the foliowing produst
InteRy Cripset Device Saftware

1t 3 strongly recammended that you eut & pregrams befor: eantmurg

Press Nexs to continue, or press Cencel 1o it the setup program

2. At the "Intel® Chipset Device Software"
screen, click "Next".

Intel(R) Chipset Device Software

License Agreement

INTEL SOFTWARE LICENSE AGREEMENT (OEM / IHV / ISV Distribution & Single
User)

IMPORTANT - READ BEFORE COPYING, INSTALLING OR USING,

Do not use or load this software and any sssociated materials (collectively, the
*Software"} until you have carefully read the following terms and conditions. By
loading or using the Saftware, you agree to the terms of this Agreement. If you do
not wish to so agree, do not install o use the Software.

Please Alsa Note:
* If you are an Original Equipment Manufacturer (OEM], Independent Hardware
Vendor (IHV), or Independent Software Vendor (1SV), this complete LICENSE
AGREEMENT applies:

* If you are an End-User, then enly Exhibit A, the INTEL SOFTWARE LICENSE
AGREEMENT, applies.

Intel(R) Chipset Device Software

Readme File Information

= Product: Intel(R) Chipset Device Software
+ Version: 10.1.1

+ Target PCH/Chipset: Client Platforms

* Date: 2015-06-03

NOTE
For the Tist of supported chipsets, please refer
to the Release Notes

* CONTENTS OF THIS DOCUMENT

This document contains the following sections:

1. Overview

2. System Requirements

3. Contents of the Distribution Package
34. Public and NDA Configurations

Back

. At the "License Agreement” screen,
click "Accept"

Intel(R) Chipset Device Software

Completian

You have successfully installed the following product:
Intel(f} Chipset Device Software

You must restart this computer for the changes to take effect.

View Log Files

Restart Now Restart Later

5. Click "Restart Now" to restart computer.

4. At the "Readme File Information" screen,
Click "Install".

NOTE: SYSTEM INSTALL will auto detect file path

For Windows 7 64/32-bit and windows 10 64bit
X:\driver\sky_lake\INF\SetupChipset.exe
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5-2 VGA

Sky Lake for Windows 10 (x64)

ME Tool

LAN

1. At the "AUTOMATIC DRIVER INSTALLATION
menu "screen, click "VGA".

Intel® Installation Framework x

Intel® Graphics Driver

ement

License Agres

You must accept all of the terms of the license agreementin order to continue the setup
program. Do you accept the terms?

Install Intel SkyLake VGA Driver

Intel® Installation Framework - X

ntel® Graphics Driver

Welcome to the Setup Program

This setup program willinstall the folloning components:
- Intel® Graphics Driver
- Intel® Display Audio Driver

Itis strongly recommended that you exit all programs before continuing. Click Nexct to continue

[ Ton WinSAT and enable the Windaws Aero deskiop theme (f suppartedy.

< Back

Cancel

Intel® Tnstallation Framework

2. At the "Welcome to the Setup Program"
screen, Click "Next".

Intel® Installation Framework - X

Intel® Graphics Driver

Readme File Information

Refer to the Readme file below to view the system requirements and instalation information.

INTEL SOFTWARE LICENSE AGREEMENT (OEM / IHV / ISV Distribution & Single User) ~

IMPORTANT - READ BEFORE COPYING, INSTALLING OR USING.

Do not use ar load this software and any associated materials (collectively, the “Software”)
untl you have carefully read the following terms and conditions. By leading or using the
Software, you agree to the terms of this Agreement. If you do not wish to so agree, do not
install or Use the Software.

Please Also Note:

= If you are an Original Equipment Manufacturer (OEM), Independent Hardware Vendor

(IHV), or Independent Software Vendor (ISV), this complete LICENSE AGREEMENT applies;

* If you are an End-User, then only Exhibit A, the INTEL SOFTWARE LICENSE AGREEMENT, ¥

Intel® Installation Framewnork

< Back Yes

Driver Version: 21.20.16.4541 ~
Release Version: Production Version
Platforms/ Operating System(s):

7th Gen Intel(R) Core(TM} processor family (Codename Kaby Lake)
Microsoft Windows™® 10-64

5th Gen Intel(R) Core(TM) processor family (codename Skylake)

Microsoft Windows™ 7-64
Microsoft Windows® 8. 1-64 v

Inkel® Installation Framework

Cancel

3. At the "License Agreement" screen,
Click "Next".

4. At the "Readme File Information" screen,
Click "Yes".
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Intel & Installation Framework Intel® Installation Framework -

Intel® Graphics Driver Intel® Graphics Driver

Setup Progress Setup Is Complete

Please wait whie the foloning setup operations are performed: You must restart this computer for the changes to take effect. Would you like to restart the
computer now?

Deleting File: C:\ProgramData) t\Windows\Start Menu 'y JHD Grag A

Deleting File: C: \ProgramData Microsoft\Windows\Start Menu'y HD Graphics |

Deleting Fil: C: programb: \ 5 v Graphics and

Deleting File: C:\Programb: \Start Menu'F ) Graphic

Deleting Fles C:\sers\PublcDeskiopIntel(R) HD Graphics Control Panelrik @it SAMBUISLnel:
Deling s € Vs Pt Dkl Gracs e Con Pk (0o, T will restart this computer later.
Deleting File: C: ProgramD: \Start Menu ) is(TM)

Deleting File: C+ sers Public|Desktopintel(R) Irks(TM) Graphics Cortrol Pangl.Ink
Deleting Registry Key: HKLM\SOFTWARE\Intel\GFX\Internal \AudioFix
Deleting Registry Key: HKLM\SOFTWARE intel\GFX\internal\AucioFix Click Finish, then remove any installation media from the drives.

Click Next to continue. v
< >

Intel® Installation Framework.

Intel@ Installation Framevork

5. At the "Setup Progress" screen, Click 6. Click "Finish" to restart computer.
"Next".

NOTE: SYSTEM INSTALL will auto detect file path
For Windows 7 64bit / Windows 10 64bit
X:\driver\sky_lake\VGA\x64\Setup.exe

For Windows 7 32bit
X:\driver\sky_lake\VGA\x86\Setup.exe

5-3 HD Audio Install Realtek High Definition Audio Driver

[Fisanek Figh Defntion Aufic Driver Setep (427 R2TS *

Sky Lake for Windows 10 (x64)

INF
ME Tool
VGA

Wekcome to the InstsBShark] Wirsed for Rrahek High Delaitin Audis Driver

LAN

The Intaliieid . outer. To

HD Audio

1. At the "AUTOMATIC DRIVER INSTALLATION 2. Click "Next",

menu"” screen, Click "HD Audio”.
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Realtek High Defintion Audic Driver Setup (4.27) RLTS

InstaliShield Wizard Complete

Rmove sy ks Fom ther dives, and then dk Firush 1o complete set.

3. Click "Finish" to restart computer

NOTE: SYSTEM INSTALL will auto detect file path

For Windows 7 64 bit / Windows 10 64 bit
X:\driver\sky_lake\Audio\0006-64bit_Win7_Win8_Win81_Win10_R279.exe
For Windows 7 32bit
X:\driver\sky_lake\Audio\Win7_Win8_Win81_R273.exe

5-4 ME Tools Install Intel Management Engine Interface Driver

ement Engine Components

‘fou are about to install the following product:
Intel® Management Engine Companents

Itis strongly recommended that you exit all programs before continuing.
Click Next to continue, or dick Cancel to exit the setup program.

ME Tool

LAN

Intel Corporation <Back Cancel

1. At the "AUTOMATIC DRIVER INSTALLATION 2. At the "Intel® Management Engine
menu" screen, Click "ME Tool" Components Driver" screen, Click" Next.
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Setup

Intel® Management Engine Components
Destination Folder

el® Management Engine Components

License Agreement

Click Next to install to the default folder, or dick Change to choose another destination folder.

INTEL SOFTWARE LICENSE AGREEMENT (OEM / IHV / ISV Distribution & Single User) A

[ c:Program Fies (x86)\intel\Intel(R) Management Engine Components |

IMPORTANT - READ BEFORE COPYING, INSTALLING OR USING.
Do not use o load this software and any associated materials (callectively, the Software)
until you have carefully read the follawing terms and conditions. By loading or using the Change...
Software, you agree to the terms of this Agreement. If you do not wish to so agree, do not =
install or use the Software.

Please Also Note:

= If you are an Original Equipment Manufacturer (OEM), Independent Hardware Vendor

{IHV), or Independent Software Vendor (ISV), this complete LICENSE AGREEMENT applies;
*If you are an End-User, then only Exhibit A, the INTEL SOFTWARE LICENSE AGREEMENT,

applies.
For OEMs, THVs, and ISVs:

LICENSE. This Software is licensed for use only in conjunction with Intel component products.
Use of the Software in conjunction with non-Intel compenent products is not licensed

[1E accept the terms in the License Agreement.;

Intel Corporation e Cancel Intel Corporation <Back Cancel

3. At the "License Agreement" screen, 4. At the "Readme File Information™ screen,

Click "Yes". Click "Next".

® Management Engine Components

Completion

You have successfully installed the following compenents:

- Intel® Management Engine Interface

- Serial Over LAN

- Local Management Service

- Intel® Management and Security Status
- Intel® Security Assist

|@|

You have successfuly installed the following product:

Intel® Management Engine Components

Click here to open log file location.

Inkel Corporation < Back Next > Finish

5. Click "Finish" to restart computer.

NOTE: The path of the file

For Windows 7 32-bit

X:\driver\sky_lake\ME\SetupME.exe

KMDF 1.11 installation required before Intel ME 10 driver installed
X:\driver\sky_lake\ME\KMDF_Win7\kmdf-1.11-Win-6.1-x86.msu
For Windows 7 64-bit

X:\driver\sky_lake\ME\SetupME.exe

KMDF 1.11 installation required before Intel ME 10 driver installed
driver\sky lake\ME\KMDF_Win7\kmdf-1.11-Win-6.1-x64.msu

For Windows 10 64-bit

X:\driver\sky_lake\ME\SetupME.exe

___________________________________________________________________________|
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5-5 LAN Install Intel LAN Driver

BB (kiR Netwesk Connections P

Intel® Network Connections

Sky Lake for Windows 10 (x64)

| Instal Diivess and Seftware

| Wies oo Guidne

ME Tool

LAN

| Metwesking a1 Intelcom

1. At the "AUTOMATIC DRIVER 2. At the "Intel® Network Connections"
INSTALLATION menu" screen, Click "LAN" screen, Click" Install Drivers and Software.

8 Intel(R) Network Connections Install Wizard x 5! Intel(R) Metwork Connections Install Wizard X
Welcome to the install wizard for Intel(R) . . License Agreement
Network Connections ( intel Please read the following license agreement carefully.
~
Installs drivers, Intel(R) Network Connections, and Advanced INTEL SOFTWARE LICENSE AGREEMENT
Networking Services.
IMPORTANT - READ BEFORE COPYING, INSTALLING OR USING.
Da not copy, install, or use this software and any associated materials
(collectively, the " Software”) provided under this license agreement
("Agreement”} until you have carefully read the following terms and conditions.
WARNING: This program is protected by copyright law and
international treaties. By copying, installing, or otherwise using the Software, you agree to be bound by
the terms of this Agreement. If you do not agree to the terms of this Agreement, ,
(@)1 zccept the terms in the license agreement Brint.

(D1 do not accept the terms in the license agreement

<ok Conca e =
3. Click "Next". 4. At the "License Agreement" screen,

Click "Next".
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Intel(R) Network Connections Install Wizard
Setup Options

Select the program features you want installed.

tel(R) PROSet for Windows ™ Device Manager
Advanced Network Services

Windows® PowerShell Module

[Cintel(r) Network Connections SNMP Agent

Feature Description

< Back

Cancel

Intel(R) Network Connections

There is an issue with Microsoft™ Windows™ 10 that prevents the Intel(R)
Advanced Network Services (Intel(R) ANS) feature from working
correctly. You may install the feature, although you will be unable to
create Intel(R) ANS Teams and VLANs. De you wish to install the
feature?

Yes

5. At the "Setup Options" screen, Click "Next".

6. Click "Next".

15! Intel(R) Network Connections Install Wizard x

Ready to Install the Program

The wizard is ready to begin installation.

=
=4
(;

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

< Back

Tnctal

Cancel

5! Intel(R) Network Connections Install Wizard

Install wizard Completed

=
=4
(;

To access new features, open Device Manager, and view the
properties of the network adapters.

X

7. At the "Ready to Install the Program screen,
Click "Insatll".

8. Click "Finish".
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B intei(R) Metwork Connections

Intel® Network Connections

8. Click "Exit".
NOTE: The path of the file

For Windows 7 64/32-bit / Windows 10 64-bit
X:\driver\sky_lake\LAN\Autorun.exe
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5-6 How to update Insyde BIOS

Step 1. To run afuwingui.exe then click "Open"

i AFUWINGUI v.1.09 (==

Information ‘ Setup ] Progress ]
System Information
0s Windows 7
Bios Size: 2621440 bytes
MainBios Size: 1703536 bytes
BootBlock Size: 655360 bytes
NVRAM Size: 262144 bytes
Core Version 0406
Project Version:  00.45
Firmware: D: Cl650049
Fimware GUID:  b5c530874eac-4b41-9d80730ba5aal70f

Bios Chip Mame: Winbond 25X/Q Series
ROM File: Information
Input Rom File:  Unknown

File Rom 1D: Unknown
File Rom GUID:  Unknown

American
Megatrends

Save Exit

Step 2. Click the new version BIOS (download from the website)

Nopen =
Lookin: [ [JJ CIB50C x| ® @ efE-
Name ° Date modified Ty
|| CIsS0C &M _A3.bin | G/13/3012 550 MBI

4 .
Filepame:  [CIB50C_8M_A3
Files of type: [ All Files %) ~| Cancel
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|
Step 3. Choose "ProgramAll Blocks" and "Do Not Check ROM ID"

RIS —
Information  Setup |Progusl I
Biock Options Miscelaneous
=% FFamnnad] [T owaoesronn]
« 5 ¥ Man BIOS image
g e I~ Boot Block [ Festat After Programeming
Q= | | neam I :
o % 5 PreseveSMBIOS [
ME Firmware Block T Non Crtical Block
"fl '” ™ lgrition r
'” i [0 k2 e N
Es:Es iy I8
[
Open | Bash | save | Eat |

Step 4. Click "Flash"
Information  Setup | Progress |

Miscelaneous
5] [¥ Do Not Check ROM ID
¥ Main BIOS knage -

SE
E L ¥ Boot Bock I Restan After Programming
o= ¥ NVRAM r
=t gl & Preseve SMBIOS [
<=

ME Femware Block —— Nen Ctscal Block
'I'” 'El I~ Ignition I=

llf i E

gpen | [ Eesh | s | Ea |

Step 5. Click "Exit" and restart computer.

i AFUWINGUT v.1.09
Information | Setup ngmﬁl
~BIOS Map with ME Block(Each Block is 32K) Legend
51 3 e 2
=i B O
< [ Erse
A 2 E [ Program
= B Verfy
=9 ’
I” Stage:
‘l"l[ Done.
IH Address:
FFFFFFFFh
Open I Flash I Save I I Exit I




Appendix A: Power Consumption Test

Condition
ltem Spec
CPU Intel Skylake-S
Memory SODIMM DDR4 2133 16GB x 2

Operating System

Windows 10_64bit

Test Program

3D Mark 06

HDD 3.5" SATA Standard HDD
HDD 2.5" SATA Slim Type HDD
mSATA 16GB
Test Result for reference only !
Hard Disk | Processor | Power off Start up Operation | Shut down In Put
Maximum | Stable | Maximum | Maximum | Voltage
i7-6700TE 0.18A 3.75A 1.17A 4.73A 2.4A 12v
i5-6500 0.18A 3.5A 1.23A 5.48A 2.46A 12v
3.5"HDD | i5-6500TE 0.18A 3.55A 1.21A 4.45A 2.24A 12v
i3-6100 0.18A 3.77A 1.22A 5.58A 2.34A 12v
G4400TE 0.18A 3.06A 1.18A 2.91A 2.01A 12v
Hard Disk | Processor | Power off Start up Operation | Shut down In Put
Maximum Stable Maximum | Maximum | Voltage
i7-6700TE 0.19A 2.61A 0.86A 4.34A 2.29A 12V
i5-6500 0.18A 3.27A 0.89A 5.38A 2.31A 12V
2.5"HDD | i5-6500TE 0.18A 2.7A 0.88A 4.26A 2.24A 12V
i3-6100 0.18A 2.76A 0.86A 5.19A 2.25A 12V
G4400TE 0.18A 2.23A 0.86A 2.57A 1.72A 12V
Hard Disk | Processor | Power off Start up Operation | Shut down In Put
Maximum Stable Maximum | Maximum Voltage
i7-6700TE 0.18A 3.31A 0.89A 4.23A 2.2A 12V
i5-6500 0.18A 3.04A 0.9A 5.07A 2.6A 12v
mSATA | i5-6500TE 0.18A 2.51A 0.88A 4.04A 2.09A 12v
i3-6100 0.18A 2.71A 0.88A 4.79A 2.31A 12v
G4400TE 0.18A 2.22A 0.86A 2.58A 1.57A 12V

The power consumption depends on your device choice!




Appendix B: Resolution list

640 x 480 x (256 / 16bit/32bit)

800 x 600 x (256 /16bit/ 32bit)

1024 x 768 x (256 / 16bit/ 32bit )

1152 x 864 x (256 / 16bit/ 32bit )

1280 x 600 x (256 / 16bit/ 32bit )

1280 x 720 x (256 / 16bit / 32bit )

1280 x 768 x (256 / 16bit / 32bit )

1280 x 800 x (256 / 16bit / 32bit )

1280 x 960 x (256 / 16bit / 32bit )

1280 x 1024 x ( 256 / 16bit / 32bit )

1400 x 1050 x (256 / 16bit / 32bit )

1440 x 900 x (256 / 16bit / 32bit )

1600 x 900 x ( 256 / 16bit / 32bit )

1600 x 1200 x ( 256 / 16bit / 32bit )

1680 x 1050 x (256 / 16bit / 32bit )

1920 x 1080 x ( 256 / 16bit / 32bit )

1920 x 1200 x ( 256 / 16bit / 32bit )
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